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EPM 9800 Advanced Power Quality 
Metering System

Chapter 1: Overview

GE Consumer & Industrial
Multilin

Overview

1.1 Introduction

1.1.1 Description
The EPM 9800 Advanced Power Quality Metering System is a unique collection of metering 
technologies to fulfill advanced metering requirements. It provides high-accuracy power 
and energy measurements of voltage, current, and all power values, as well as data 
logging and power quality recording. The unit makes the data available through the 
display, connected systems, and historic logs.

Figure 1-1: Front view

1.1.2 Theory of Operation
The advanced metering capability of the EPM 9800 is a result of the meter’s high-speed 
sampling, measurement, and calculation functions. All voltage and current waveforms are 
sampled and RMS values calculated continuously every cycle. Values of voltage, current 
and power are produced every three cycles and every second.
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The following figure illustrates the key processes operating within the EPM 9800. The meter 
allows for four types of inputs and can provide outputs to an integrated display, pulse 
outputs and several communication ports.

Figure 1-2: Input processing

Voltage and current signals are sampled at up to 256 samples per cycle. Each sample is 
resolved using 16-bit analog-to-digital converters. Two 16-bit analog-to-digital converters 
are used for the EPM 9800 – the first is for the real-time measurements and the second for 
the waveform recorder. The use of two analog-to-digital converters ensures that both 
signals have maximum resolution, accuracy and integrity. The second converter also 
isolates energy sampling and calculations from the waveform fault recording 
requirements. This provides both advanced energy and advanced waveform analysis.

The digitized signals are then passed to the appropriate processor. Real time 
measurements are calculated in one processor and made available for meter readings 
and logs. A separate processor performs waveform recording. Calculated data and logs 
are stored in memory for delivery to displays, external systems and download processes.

The meter includes a time synchronizing input port that accepts industry standard IRIG-B 
signals to synchronize meter time. If there is no IRIG-B signal, the meter uses a time 
synchronizing input port that uses line frequency to synchronize meter time to standard 
universal time. The line synchronization feature may be enabled or disabled. If it is 
disabled, the internal clock provides time synchronization. All readings and logs are time 
stamped to the nearest millisecond.

Eight status channels provide status inputs or pulse signals. Status inputs are time- 
stamped to the nearest millisecond and placed in the event log. Pulse inputs are multiplied 
by a user-supplied value and accumulated in reading registers. These accumulated values 
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can also be totalized. This feature makes the EPM 9800 ideal for universal metering 
applications. Any input channel can be selected to accept an end-of-interval pulse from 
another meter.

Meter parameters and all historical log data are stored in NVRAM. The meter has multiple 
log functionality and data is available through the front panel display (see Display Screens 
on page 1–6). Several additional communication channels operate simultaneously, 
including the optional Ethernet/modem combo card. External systems can be connected 
to either of the RS485 ports or the Ethernet/modem port. Stored data can be downloaded 
through the RS485 ports, the Ethernet/modem port or the optical port.
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1.2 Functionality

1.2.1 Advanced Revenue Billing Capability
The EPM 9800 is a full four-quadrant power meter with an accuracy within 0.06% of 
reading. Measurements include delivered and received real energy (kWh), delivered and 
received reactive energy (kvarh), apparent energy (kVAh), real and reactive energy in each 
quadrant (kWh and kvarh), and total apparent energy (kVAh). It measures instantaneous 
power and provides multiple, simultaneous demand measurements, including time-
stamped maximum and minimum readings.

The EPM 9800 time of use functionality offers the following standard capabilities:

• eight (8) time-of use (TOU) schedules

• bidirectional consumption and demand

• four (4) seasons per year with a twenty (20) year calendar

• prior month and prior season readings for each schedule

• present month and present season readings for each schedule

• total to date readings for each month and each season

• cumulative and continuous cumulative demand

Using standard pulse inputs, the EPM 9800 can count pulses from external meters and 
accumulate usage. The pulse inputs can be used to totalize electrical usage and utility 
values, such as water or gas use data. Readings include:

• eight (8) pulse inputs for load aggregation

• individual accumulating registers

• four (4) totalizing registers

• totalize with real energy (kWh) readings

The EPM 9800 simultaneously monitors four demand structures. The unit offers:

• block window demand

• rolling window demand

• predictive demand

• thermal demand

• interval length from one (1) second to many hours

• up to fifteen (15) sub-intervals

• end of interval pulse output

• end of interval pulse input

The unit gathers time-stamped minimum/maximum demands for all power values. Each of 
the following values is date/time stamped:

• real power (kW) demand, delivered and received, minimum/maximum

• reactive power (kvar) demand, delivered and received, minimum/maximum

• reactive power (kvar) coincident with real power (kW) demand

• apparent power (kVA) demand, minimum/maximum

• current demand, minimum/maximum
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• voltage demand, minimum/maximum

A user-defined transformer loss compensation adjusts for both copper and iron losses.

1.2.2 Advanced Communications and Input/Output Capabilities
The EPM 9800 has advanced communication features that use multiple communication 
ports over open protocols. The multi-port design allows multiple simultaneous 
connections. The EPM 9800 provides a direct digital link to customers, allowing them to 
gather selected data without effecting the meter or its data. All of the advanced features of 
the EPM 9800 are made available through industry-standard Modbus and DNP 3.0 
protocols. No proprietary or closed protocols are used.

Standard communications features include:

• ANSI type 2 optical port (infrared port)

• two (2) RS485 serial ports

• Modbus RTU/ASCII and DNP 3.0 Level 2+ protocol compatibility

• speeds up to 115 kbps

The EPM 9800 allows an additional port for one of the following uses:

• internal 56k modem with noise rejection

• internal Ethernet TCP/IP (10/100Base-T) with multiple sockets and Modbus TCP 
server functions

• combination 56 kbps modem and internal Ethernet TCP/IP (10/100Base-T)

Extensive input/output capability is available in conjunction with all metering functions.

• IRIG-B time synchronizing to GPS with 1 millisecond resolution

• eight (8) high-speed pulse/status inputs for status detect or of load aggregation/
universal metering inputs

• line frequency time synchronization

The meter comes equipped with four standard internal KYZ pulse outputs for generating 
energy and power signals that can be sent to external devices, such as PLCs. These can be 
set to pulse for any accumulated reading. One output can also be set for an end-of-
interval “sync” pulse.

The user can also select from the following external input/output modules:

• analog inputs and outputs

• additional status inputs

• KYZ outputs

• relay/alarm outputs

The following control options are available:

• user-definable control outputs

• action and/or alarm on abnormal condition

• action on Boolean logic combinations of inputs or electrical conditions



1–6 EPM 9800 ADVANCED POWER QUALITY METERING SYSTEM – USER GUIDE

OVERVIEW CHAPTER 1: OVERVIEW

1.2.3 Display Screens
The EPM 9800 features a back-lit LCD display with extended temperature voltage 
compensation. This allows viewing of energy data and the gathering of circuit diagnostic 
data such as voltage, current, harmonics and phasor information. This display is easily 
programmable. Refer to Programmable Display on page 4–8 for additional details.

1.2.4 Additional Switches
The EPM 9800 has additional switches and signals that help in using the unit (see Figure 1-
2: Input processing on page 1–2).

• The infrared test pulse can be set to pulse for positive real energy (+Wh), negative 
real energy (–Wh), positive reactive energy (+varh), negative reactive energy (–
varh), and apparent energy (VAh). The pulse uses a time-modulated pulse 
integration which allows the pulse to be accurate during short duration pulse 
tests. The pulse integration uses industry-accepted reference standards.

• The mode switch (magnetic reed switch) uses a magnet to switch operating 
modes.

• The test button.

• The reset button.

1.2.5 External Input/Output Modules
A variety of optional analog or digital input/output modules mount externally to the EPM 
9800 socket meter. The EPM 9800 does not support internal input/output modules. Use an 
auxiliary power supply, such as the PSIO, to provide input/output capability. See Input/
Output Module Wiring on page 3–37 for details on installation and usage of the external 
input/output modules.
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1.3 EN 50160 Flicker

1.3.1 Description
The EPM 9800 provides EN 50160 flicker evaluation in instantaneous, short-term and long-
term forms. Flicker is the sensation that is experienced by the human visual system when it 
is subjected to changes occurring in the illumination intensity of light sources. The primary 
effects of flicker are headaches, irritability and sometimes epilepsy.

IEC 61000-4-15 and former IEC 868 describe methods used to determine flicker severity. 
This phenomenon is strictly related to the sensitivity and the reaction of individuals. It can 
only be studied on a statistical basis by setting up suitable experiments among people.

1.3.2 Theory of Operation
Flicker can be caused by voltage variations which are caused by variable loads, such as 
arc furnaces, laser printers and microwave ovens. To model the eye brain change (a 
complex physiological process), the signal from the power network has to be processed 
while conforming with figure below.

Figure 1-3: Simulation of eye-brain response

Block 1 consists of scaling circuitry and an automatic gain control function that normalizes 
input voltages to blocks 2, 3 and 4. For the specified 50 Hz operation, the voltage standard 
is 230 V RMS. Block 2 recovers the voltage fluctuation by squaring the input voltage scaled 
to the reference level. This simulates the behavior of a lamp.

Block 3 is composed of a cascade of two filters and a measuring range selector. In this 
implementation, a log classifier covers the full scale in use so the gain selection is 
automatic and not shown here. The first filter eliminates the DC component and the 
double mains frequency components of the demodulated output.

The configuration consists of a 0.05 Hz Low High Pass filter and a six-pole Butterworth low 
pass filter located at 35 Hz. The second filter is a weighting filter that simulates the 
response of the human visual system to sinusoidal voltage fluctuations of a coiled 
filament, gas-filled lamp (60 W at 230 V). The filter implementation of this function is as 
specified in IEC 61000-4-15.
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Block 4 is composed of a squaring multiplier and a low pass filter. The human flicker 
sensation via lamp, eye and brain is simulated by the combined non-linear response of 
Blocks 2, 3, and 4.

Block 5 performs an online statistical cumulative probability analysis of the flicker level. 
Block 5 allows direct calculation of the evaluation parameters Pst and Plt .

Flicker is computed using the three phase-to-neutral voltages in wye configurations and 
the three phase-to-phase voltages when in delta. Evaluation occurs in the following forms: 
instantaneous, short term, or long term. Each form is detailed below.

1.3.3 Instantaneous Flicker Evaluation
An output of 1.00 from Block 4 corresponds to the reference human flicker perceptibility 
threshold for 50% of the population. This value is measured in perceptibility units (PU) and 
is labeled Pinst . This ia a real time value and it is continuously updated.

1.3.4 Short-term Flicker Evaluation
An output of 1.00 from Block 5 (corresponding to the Pst value) corresponds to the 
conventional threshold of irritability per IEC 1000-3-3. To evaluate flicker severity, two 
parameters have been defined: one for the short term called Pst (defined in this section) 
and one for the long term called Plt (defined in the next section).

The standard measurement time for Pst is 10 minutes. Pst is derived from the time at level 
statistics obtained from the level classifier in Block 5 of the flicker meter. The following 
formula is used:

 (EQ 1.1)

where the percentiles P0.1, P1, P3, P10, and P50 are the flicker levels exceeded for 0.1, 1, 2, 20 
and 50% of the time during the observation period, respectively. The suffix “S” in the 
formula indicates that the smoothed value should be used. The smoothed values are 
obtained using the following formulas:

 (EQ 1.2)

 (EQ 1.3)

 (EQ 1.4)

 (EQ 1.5)

The 0.3 second memory time constant in the flicker meter ensures that P0.1 cannot change 
abruptly and no smoothing is needed for this percentile.

Pst 0.0314P0.1 0.0525P1s 0.0657P3s 0.28P10s 0.08P50s+ + + +=

P1s
P0.7 P1 P1.5+ +

3
-------------------------------------=

P3s
P2.2 P3 P4+ +

3
----------------------------------=

P10s
P6 P8 P10 P13 P17+ + + +

5
---------------------------------------------------------------=

P50s
P30 P50 P80+ +

3
--------------------------------------=
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1.3.5 Long-term Flicker Evaluation
The 10 minute period on which the short-term flicker severity is based is suitable for short 
duty cycle disturbances. For flicker sources with long and variable duty cycles (for example, 
arc furnaces) it is necessary to provide criteria for long-term assessment. For this purpose, 
the long-term Plt is derived from the short-term values over an appropriate period. By 
definition, this is 12 short-term values of 10 minutes each over a period of 2 hours. The 
following formula is used:

 (EQ 1.6)

where Psti (i = 1, 2, 3,...) are consecutive readings of the short-term severity Pst .

1.3.6 Summary
In summary, we have:

• Flicker is the changes in the illumination of light sources due to cyclical voltage 
variations.

• Pinst represents the instantaneous flicker values in perceptibility units (PU).

• Pst represents the value based on 10 minute analysis.

• Plt represents the value based on 12 Pst values.

The measurement procedure is as follows:

1. Original signal with amplitude variations.

2. Square demodulator.

3. Weighted filter.

4. Low pass filter (first order).

5. Statistical computing.

The following data is available:

• Pst and the maximum and minimum Pst values for long term recording

• Plt and the maximum and minimum Plt values for long term recording

Plt

Psti
3

i 1=

n

∑

N
------------------3

=
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1.4 Ordering

1.4.1 Order Codes
The order codes for the EPM 9800 meter are shown below:

Table 1–1: EPM 9800 order codes
PL9800 – * – * – * – * – * – *

Base unit PL9800 | | | | | | EPM 9800 Advanced Power Quality Metering System
System frequency 5 | | | | | 50 Hz AC frequency system

6 | | | | | 60 Hz AC frequency system
Power supply S | | | | Blade powered, 102 to 550 V AC auto-ranging

E | | | | External, 102 to 275 V AC/DC auto-ranging
D | | | | External, 18 to 60 V DC auto-ranging
L | | | | Blade powered, 69 V AC

Form 9S | | | 0 to 277 V L-N; 3E, 4W wye
36S | | | 0 to 277 V L-N; 2.5E, 4W wye
45S | | | 0 to 480 V L-L; 2E, 3W delta
9A | | | 0 to 277 V L-N; A-base form
SB | | | switchboard (power supplies E and D only)

Logging options S | | standard (see specifications)
A | | advanced (see specifications)

Communications R | 2 RS485 ports
W | 2 RS485 ports and 10/100Base-T Ethernet
M | 2 RS485 ports and 56 kbps dial-out modem
C | 2 RS485 ports, 56 kbps modem, and Ethernet gateway

Class amps 2 2 amps
20 20 amps
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1.4.2 External Modules
The following external modules are available:

Note External modules and accessories must be ordered separately from base meters.

Analog output modules:

Analog input modules:

Digital input/output modules:

Auxiliary input/output power supply and mounting:

Meter display module and software:

PL9000 – * – * – * – * – * – * – * – 0 – 0
1 M A O N 4 0 0 0 Four channel 0 to 1 mA analog outputs
1 M A O N 8 0 0 0 Eight channel 0 to 1 mA analog outputs
2 O M A O N 4 0 0 Four channel 4 to 20 mA analog outputs
2 O M A O N 8 0 0 Eight channel 4 to 20 mA analog outputs

PL9000 – * – * – I – * – 0 – 0 – 0 – 0 – 0
8 A I 1 0 0 0 0 0 Eight channel 0 to 1 mA analog inputs
8 A I 2 0 0 0 0 0 Eight channel 4 to 20 mA analog inputs
8 A I 3 0 0 0 0 0 Eight channel 0 to 5  V DC analog inputs
8 A I 4 0 0 0 0 0 Eight channel 0 to 10  V DC analog inputs

PL9000 – * – * – * – 1 – 0 – 0 – 0 – 0 – 0
4 R 0 1 0 0 0 0 0 Four channel control relay outputs
4 P 0 1 0 0 0 0 0 Four channel KYZ solid-state pulse outputs
8 D I 1 0 0 0 0 0 Eight channel auxiliary digital status inputs

PL9000 – * – * – I – O – 0 – 0 – 0 – 0 – 0
M B I O 0 0 0 0 0 Mounting bracket (one per module group)
P S I O 0 0 0 0 0 Auxiliary power supply (>4 modules)

PL9000 – * – * – * – * – 0 – 0 – 0 – 0 – 0
P 4 0 N 0 0 0 0 0 Three-line LED display
P 6 0 N 0 0 0 0 0 Touch-screen LCD display
N C M 1 0 0 0 0 0 GE Communicator EXT software, single user
N C M 5 0 0 0 0 0 GE Communicator EXT software, five users
N C M S 0 0 0 0 0 GE Communicator EXT software, single site
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1.5 Specifications

1.5.1 Power Supply

STANDARD POWER SUPPLY (OPTION S)
Rating:..................................................................120 to 550 V AC auto-ranging, three-phase
Total burden:.....................................................12 VA worst-case
Source:.................................................................meter power provided by any of the monitored phase 

voltage sources
Power:..................................................................blade powered

EXTERNAL POWER SUPPLY (OPTION E)
Rating:..................................................................102 to 275 V AC
Power consumption:.....................................16 VA at 276 V AC maximum
Source:.................................................................separate power cord

LOW VOLTAGE POWER SUPPLY (OPTION L)
Rating:..................................................................69 V AC ±20%
Application: .......................................................low voltage supply for 69 V L-N applications

EXTERNAL LOW VOLTAGE POWER SUPPLY (OPTION D)
Rating:..................................................................18 to 60 V DC
Application: .......................................................low voltage supply for DC powered applications 

(switchboard meter is always separately powered)

1.5.2 Inputs

INPUT CURRENT
Current inputs: .................................................3 or 4, depending on form (IA, IB, IC, and IN)
CT rating: ............................................................0 to 20 A, class 20

0 to 2 A, class 2
Continuous current: ......................................120% of meter class
Overload: ............................................................500% for 1 second, non-recurring

INPUT VOLTAGE
Line-to-neutral: ...............................................0 to 360 V
Line-to-line: .......................................................0 to 660 V

BURDEN (SENSE INPUTS)
Voltage inputs:.................................................0.33 VA at 576 V
Current inputs: .................................................0.012 VA at 25 A

ISOLATION
Inputs/outputs: ................................................isolated to 2500 V
Communications ports: ...............................isolated to 1000 V

DIGITAL INPUTS
Inputs: ..................................................................8
Type: .....................................................................self-excited, for dry contacts only
Internal wetting voltage:.............................12 V DC (typical)

ANALOG TRANSDUCER SIGNAL INPUTS
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Modules: .............................................................8 channel 0 to 1 mA bi-directional
8 channel 0 to 20 mA bi-directional
8 channel 0 to 5 V DC bi-directional
8 channel 0 to 10 V DC bi-directional

Wiring: .................................................................common mode
Accuracy: ...........................................................0.25% of full-scale
Scaling:................................................................programmable

CLOCK
Internal:...............................................................internal clock crystal, accuracy better than 1 minute per 

month
Line synchronization:....................................accuracy better than 1 second per month
IRIG-B input: ......................................................accuracy better than 1 ms per month

1.5.3 Outputs

SOLID-STATE OUTPUTS (KYZ)
Type: .....................................................................form-A or form-C
On resistance: ..................................................25 to 35 Ω
Peak voltage: ....................................................350 V DC
Continuous load current: ............................120 mA
Peak load current:..........................................350 mA for 10 ms
Off-state leakage current:..........................1 μA at 350 V DC
Opto-isolation: .................................................3750 V RMS (60 Hz at 1 minute)

DIGITAL DRY RELAY CONTACT OUTPUTS
Rating:..................................................................5 A at 125 V AC/DC
Form: ....................................................................form-C

DIGITAL SOLID-STATE PULSE OUTPUTS
Form: ....................................................................form-A or form-C KYZ pulses
Maximum pulse speed: ...............................20 pulses per second

ANALOG TRANSDUCER SIGNAL OUTPUTS
Modules: .............................................................4 channel 0 to 1 mA bi-directional analog outputs;

8 channel 0 to 1 mA bi-directional analog outputs;
4 channel 0 to 1 mA analog outputs;
8 channel 0 to 1 mA analog outputs

Wiring: .................................................................common mode
Accuracy: ...........................................................0.1% of full-scale
Calibration: ........................................................self-calibrating
Scaling:................................................................programmable

1.5.4 Data Logger

STANDARD MEMORY
Historical log 1:................................................85 days (assumes 4 scaled energy readings every 15 

minutes)
Historical log 2:................................................133 days (assumes 4 scaled energy readings every 15 

minutes)
SBEMA/ITIC: .......................................................512 event (assumes 14 parameters monitored)
Out-of-limit log: ...............................................1024 events (assumes 14 parameters monitored)
Waveform log: .................................................63 records (each record may be 8 to 64 cycles in 

duration)
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Flicker log: ..........................................................1536 records
Output log:.........................................................256 records
Input log:.............................................................1024 records
System events: ................................................1024 events (assumes 14 parameters monitored)

ADVANCED MEMORY
Historical log 1:................................................555 days (assumes 4 scaled energy readings every 15 

minutes)
Historical log 2:................................................133 days (assumes 4 scaled energy readings every 15 

minutes)
SBEMA/ITIC: .......................................................512 event (assumes 14 parameters monitored)
Out-of-limit log: ...............................................1024 events (assumes 14 parameters monitored)
Waveform log: .................................................95 records (each record may be 8 to 64 cycles in 

duration)
Flicker log: ..........................................................5120 records
Output log:.........................................................256 records
Input log:.............................................................1024 records
System events: ................................................1024 events (assumes 14 parameters monitored)

1.5.5 Communications

STANDARD
Display: ................................................................LCD
Ports: ....................................................................IR port, two RS485 serial ports
Protocols:............................................................Modbus RTU, Modbus ASCII, DNP 3.0
Data rate: ...........................................................up to 115 kbps
Inputs channels:..............................................8 high-speed

OPTIONAL
Modem: ...............................................................56K modem with dial-out capabilities
Ethernet: .............................................................internal 10/100Base-T;

internal 10/100Base-T with 56K modem combination
Protocols:............................................................Modbus TCP, DNP LAN/WAN

1.5.6 Physical

ENVIRONMENTAL
Operating temperature: ..............................–40 to 85°C
Display temperature:....................................–20 to 60°C
Seal: ......................................................................rain-tight Lexan cover (socket)

SHIPPING
Weight: ................................................................8 lbs (socket); 14 lbs (switchboard)
Dimensions:.......................................................10" x 11" x 13" (socket); 16" x 14" x 11" (switchboard)

1.5.7 Compliance

COMPLIANCE STANDARDS
ANSI: .....................................................................ANSI C12.20 certified
IEC:.........................................................................IEC 60687 certified
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APPROVALS
IEC:.........................................................................IEC 60687 KEMA certified

IEC 1000-4-2 Electrostatic discharge
IEC 1000-4-3 Radiated immunity
IEC 1000-4-4 Fast transient
IEC 1000-4-5 Surge immunity
IEC 1000-4-6 Conducted immunity
IEC 60068-2-6 Vibration (sinusoidal)
IEC 60068-2-27 Shock test
IEC 695-2-1 Resistance to heat and fire
IEC 529 Dust and water
IEC 68-2-1 Cold temperature test
IEC 68-2-2 Dry heat
IEC 68-20-30 Damp heat

ANSI/IEEE:...........................................................C37.90.1 Surge withstand
C62.41 Surge immunity
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EPM 9800 Advanced Power Quality 
Metering System

Chapter 2: Electrical Background

GE Consumer & Industrial
Multilin

Electrical Background

2.1 Overview

2.1.1 Description
The EPM 9800 Advanced Power Quality Metering System can be installed in three ways:

• As a type S meter.

• As a type A meter (on an A-base)

• As a type Z meter (in a switchboard case)

The following section provides the field technician the basic steps for installation of the 
type S meter. These steps are described in greater in later chapters of this manual.
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2.2 Start-up and Bench Check

2.2.1 Meters with Auxiliary Power
If the meter has an auxiliary power cable, apply appropriate power to the two leads of the 
power cable. Meter information scrolls on the display.

FIGURE 2–1: EPM 9800 rear view

2.2.2 Meters without Auxiliary Power
To energize meters without auxiliary power, apply appropriate power to the voltage 
terminals of the meter. Terminals vary by meter form. The EPM 9800 meter form (FM 9S, 
36S, or 45S) is shown in the white block under the display.

Use the following figures to determine the terminals.

FIGURE 2–2: EPM 9800 auxiliary terminals

For form 9S and 36S meters, connect appropriate power to the one of the three left-most 
and to the right most voltage terminals (center row of smaller terminals). These are the 
small, bold terminals in the above figure (the large terminals are current terminals for 
these forms).

Cable 2
high-speed
inputs

Cable 3
optional KYZ cable

Cable 1
port 1, port4, IRIG-B

Cable 8
optional auxiliary

power cable

OPTIONAL COMMUNICATIONS
1. Combination Modem/Ethernet:

2. Modem

3. Ethernet

Cable 4 - RS485 gateway
Cable 5 - RJ11 modem
Cable 6 - RJ45 Ethernet

Cable 4 - RS485 gateway
Cable 5 - RJ11 modem
Cable 7 - battery

Cable 6 - RJ45 Ethernet

Voltage terminals

Common

Form 9S and 36S Form 45S



CHAPTER 2: ELECTRICAL BACKGROUND ELECTRICAL BACKGROUND

EPM 9800 ADVANCED POWER QUALITY METERING SYSTEM – USER GUIDE 2–3

Form 45S uses only the large terminals as indicated above

When the meter is energized, the display lights up and scrolls meter information. This 
completes a 95% test of meter functionality.
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2.3 Serial Communications

2.3.1 Optical Port
Connect with Modbus RTU at 9600 baud (initial setting). The A7Z communications interface 
cable requires no power supply – all power is received from the host PC serial port via 
circuits in the probe. Connect the A7Z interface cable at one end to the EPM 9800 optical 
port. At the other end, connect to the 9-pin RS232 serial port on the PC.

2.3.2 Serial Port
Connect with Modbus RTU at 57600 bps. Connect port 1 (or 4) of the EPM 9800 to the PC 
RS232 serial port via the GE Multilin F485 converter.

FIGURE 2–3: Serial communications

PC

Optical port RS232

Port 1 or 4
RS485

GE Multilin
F485 RS485-to-RS232

converter
RS232

EPM 9800

EPM 9800
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2.4 EPM 9800 Calculations

2.4.1 Description
The EPM 9800 Advanced Power Quality Metering System measures many different power 
parameters. This section illustrates the formulas used to perform calculations with 
samples for Wye and Delta services.

• samples for wye: Van, Vbn, Vcn, Ia, Ib, Ic, In

• samples for Delta: Vab, Vbc, Vca, Ia, Ib, Ic

2.4.2 Voltage
The root mean square (RMS) of phase to neutral voltages for wye connections is shown 
below, where n is the number of samples and x represents an, bn, and cn.

 (EQ 2.1)

The root mean square (RMS) of phase to phase voltages for wye connections is shown 
below, where n is the number of samples and x,y represents an, bn; bn, cn; or cn, an.

 (EQ 2.2)

The root mean square (RMS) of phase to phase voltages for delta connections is shown 
below, where n is the number of samples and xy represents ab, bc, or ca.

 (EQ 2.3)

2.4.3 Current
The root mean square (RMS) of currents is shown below, where n is the number of samples 
and x represents a, b, c, and n for wye connections, and a, b, and c for delta connections.

 (EQ 2.4)

Vx

vx t( )
2

t 1=

n

∑

n
---------------------=

Vxy

vx t( ) vy t( )–( )2

t 1=

n

∑

n
---------------------------------------------=

Vxy

vxy t( )
2

t 1=

n

∑

n
-----------------------=

Ix

ix t( )
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2.4.4 Real Power
The per-phase real power (in watts) for wye connections is shown below, where n is the 
number of samples and x represents a, b, and c.

 (EQ 2.5)

The total real power (in watts) for wye connections is shown below.

 (EQ 2.6)

The total real power (in watts) for delta connections is shown below, where n is the number 
of samples.

 (EQ 2.7)

2.4.5 Reactive Power
The per-phase reactive power (in vars) for wye connections is shown below, where x 
represents a, b, and c.

 (EQ 2.8)

The total reactive power (in vars) for wye connections is shown below.

 (EQ 2.9)

The total reactive power (in vars) for delta connections is shown below, where n is the 
number of samples, and VAB, VBC, IA, and IC are RMS values.

 (EQ 2.10)

2.4.6 Apparent Power
The per-phase apparent power (in VA) for wye connections is shown below, where x 
represents a, b, and c.

 (EQ 2.11)

The total apparent power (in VA) for wye connections is shown below.

 (EQ 2.12)
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The total apparent power (in VA) for delta connections is shown below.

 (EQ 2.13)

2.4.7 Q per Phase and Total
The per-phase Q for wye connections is shown below, where x represents a, b, and c.

 (EQ 2.14)

The total Q for wye connections is shown below.

 (EQ 2.15)

The total Q for delta connections is shown below.

 (EQ 2.16)

2.4.8 Energy
The total energy is shown below, where X represents real energy (in Wh), reactive energy (in 
varh), and apparent energy (in VAh), and Q-energy (in Qh).

 (EQ 2.17)

2.4.9 Power Factor
The power factor is shown below, where x represents A, B, and C, and T for wye 
connections, and T for delta connections.

 (EQ 2.18)

The total average power factor is shown below, where x represents quadrants 1 and 4 (for 
positive Wh) or quadrants 2 and 3 (for negative Wh).

 (EQ 2.19)

2.4.10 Phase Angles
Phase angles are calculated as follows, where X = A, B, or C.

 (EQ 2.20)
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2.4.11 Total Harmonic Distortion
The total harmonic distortion (THD, in %) is shown below, where x represents Van, Vbn, Vcn, 
Ia, Ib, and Ic for wye connections, and Vab, Vbc, Vca, Ia, Ib, and Ic for delta connections.

 (EQ 2.21)

2.4.12 K-factor
The K-factor is shown below, where x represents Ia, Ib, and Ic.

 (EQ 2.22)

2.4.13 Imbalance
The voltage imbalance is shown below.

 (EQ 2.23)

The current imbalance is shown below.

 (EQ 2.24)
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2.5 Demand Integrators

2.5.1 Description
Power utilities take into account both energy consumption and peak demand when billing 
customers. Peak demand, expressed in kilowatts (kW), is the highest level of demand 
recorded during a set period of time, called the interval. The EPM 9800 supports the 
following conventions for averaging demand and peak demand: thermal demand, block 
window demand, rolling window demand, and predictive window demand. All conventions 
are programmable and can be accessed via the GE Communicator EXT software.

2.5.2 Thermal Demand
Traditional analog watt-hour (Wh) meters use heat-sensitive elements to measure 
temperature rises produced by an increase in current flowing through the meter. A pointer 
moves in proportion to the temperature change, providing a record of demand. The 
pointer remains at peak level until a subsequent increase in demand moves it again, or 
until it is manually reset. The EPM 9800 mimics traditional meters to provide thermal 
demand readings.

Each second, as a new power level is computed, a recurrence relation formula is applied. 
This algorithm recomputes the thermal demand by averaging a small portion of the new 
power value with a large portion of the previous thermal demand value. The proportioning 
of new to previous is programmable, set by an averaging interval. The averaging interval 
represents a 90% change in thermal demand to a step change in power.

2.5.3 Block (fixed) Window Demand
Fixed window demand produces an average (arithmetic mean) of power readings over a 
programmed interval.

For example, a typical setting of 15 minutes produces an average value every 15 minutes 
(at 12:00, 12:15, 12:30, etc.) for power readings over the previous fifteen minute interval 
(11:45 to 12:00, 12:00 to 12:15, 12:15 to 12:30, etc.).

2.5.4 Rolling (sliding) Window Demand
Rolling window demand functions like multiple, overlapping block window demands. The 
programmable settings provided are the number and length of demand subintervals. For 
every subinterval, an average (arithmetic mean) of power readings over the subinterval is 
internally calculated. This new subinterval average is then averaged (arithmetic mean) 
with as many previous subinterval averages as programmed to produce the rolling 
window demand.

For example, with settings of three five-minute subintervals, subinterval averages are 
computed every five minutes (12:00, 12:05, 12:10, 12:15. etc.) for power readings over the 
previous five-minute interval (11:55 to 12:00, 12:00 to 12:05, 12:05 to 12:10, 12:10 to 12:15, 
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etc.). Further, every five minutes, the subinterval averages are averaged in groups of three 
(12:00, 12:05, 12:10; 12:05, 12:10, 12:15. etc.) to produce a fifteen (5 × 3) minute average 
every five minutes (rolling (sliding) every five minutes; 11:55 to 12:10, 12:00 to 12:15, etc.).

2.5.5 Predictive Window Demand
Predictive window demand expands on the above rolling window demand. Rolling window 
demand waits until the end of a subinterval to update the demand. Predictive window 
demand uses the average of the previously completed subinterval, weighted by a 
programmable factor, to predict the average of the upcoming subinterval During the next 
subinterval, as actual power readings occur, the value for the subinterval consists of the 
portion actually measured plus the prediction, pro-rated to the subinterval time remaining.

Example

Using the previous settings of three 5 minute intervals, and a new setting of 120% 
prediction factor, the working of the predictive window demand could be described as 
follows.

At 12:10, we have the average of the subintervals from 11:55 to 12:00, 12:00 to 12:05 and 
12:05 to 12:10. In five minutes, we will have an average of the subintervals 12:00 to 12:05 
and 12:05 to 12:10 (which we know) and 12:10 to 12:15, which we do not yet know. As a 
guess, we will use the last subinterval (12:05 to 12:10), as an approximation for the next 
subinterval (12:10 to 12:15). As a further refinement, we will assume that the next 
subinterval might have a higher average (120%) than the last subinterval. As we progress 
into the subinterval, (for example, up to 12:11), the predictive window demand will be the 
average of the first two subintervals (12:00 to 12:05, 12:05 to 12:10), the actual values of 
the current subinterval (12:10 to 12:11) and the prediction for the remainder of the 
subinterval, 4/5 of 120% of the 12:05 to 12:10 subinterval.

Consider the following definitions:

n = number of subintervals
l = subinterval length
c = partial subinterval length
p = prediction factor

Graphically, these can be represented as follows:

We have:

 (EQ 2.25)

 (EQ 2.26)

Sub(n) Sub(n–1) ... Sub(1) Sub(0) Partial Predict

l l l l c l
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-----------------------=
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c
-----------------------=
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The predictive window demand is:

 (EQ 2.27)
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2.6 Three-phase System Configurations

2.6.1 Description
Three-phase power is most commonly used in situations where large amounts of power 
will be used because it is a more effective way to transmit the power and because it 
provides a smoother delivery of power to the end load. There are two commonly used 
connections for three-phase power, a wye connection or a delta connection. Each 
connection has several different manifestations in actual use. When attempting to 
determine the type of connection in use, it is a good practice to follow the circuit back to 
the transformer serving the circuit. It is often not possible to conclusively determine the 
correct circuit connection simply by counting the wires in the service or checking voltages. 
Checking the transformer connection will provide conclusive evidence of the circuit 
connection and the relationships between the phase voltages and ground.

2.6.2 Wye Connection
The wye connection is so called because the phase relationships and the winding 
relationships between phases resemble the letter “Y”. The following figure depicts the 
winding relationships for a wye-connected service. In a wye service the neutral (or center 
point of the wye) is typically grounded. This leads to common voltages of 208/120 and 480/
277 (where the first number represents the phase-to-phase voltage and the second 
number represents the phase-to-ground voltage).

FIGURE 2–4: Three-phase wye winding

The three voltages are electrically separated by 120°. Under balanced load conditions with 
unity power factor, the currents are also separated by 120°. However, unbalanced loads 
and other conditions can cause the currents to depart from the ideal 120° separation.

Three-phase voltages and currents are usually represented with a phasor diagram. A 
phasor diagram for the typical connected voltages and currents is shown below.
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FIGURE 2–5: Three-phase voltage and current phasors for wye winding

The phasor diagram shows the 120° angular separation between the phase voltages. The 
phase-to-phase voltage in a balanced three-phase wye system is 1.732 times the phase-
to-neutral voltage. The center point of the wye is tied together and is typically grounded. 
The following table indicates the common voltages used in the United States for wye-
connected systems.

Usually, a wye-connected service will have four wires: three wires for the phases and one 
for the neutral. The three-phase wires connect to the three phases. The neutral wire is 
typically tied to the ground or center point of the wye (refer to the Three-phase wye 
winding diagram above).

In many industrial applications the facility will be fed with a four-wire wye service but only 
three wires will be run to individual loads. The load is then often referred to as a delta-
connected load but the service to the facility is still a wye service; it contains four wires if 
the circuit is traced back to its source (usually a transformer). In this type of connection the 
phase-to-ground voltage will be the phase-to-ground voltage indicated in the table above, 
even though a neutral or ground wire is not physically present at the load. The transformer 
is the best place to determine the circuit connection type because this is a location where 
the voltage reference to ground can be conclusively identified.

Table 2–1: Common phase voltages on wye services

Phase-to-ground voltage Phase-to-phase voltage

120 volts 208 volts

277 volts 480 volts

2400 volts 4160 volts

7200 volts 12470 volts

7620 volts 13200 volts
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2.6.3 Delta Connection
Delta connected services may be fed with either three wires or four wires. In a three-phase 
delta service the load windings are connected from phase-to-phase rather than from 
phase-to-ground. The following figure shows the physical load connections for a delta 
service.

FIGURE 2–6: Three-phase delta winding relationship

In this example of a delta service, three wires will transmit the power to the load. In a true 
delta service, the phase-to-ground voltage will usually not be balanced because the 
ground is not at the center of the delta.

The following diagram shows the phasor relationships between voltage and current on a 
three-phase delta circuit.

In many delta services, one corner of the delta is grounded. This means the phase to 
ground voltage will be zero for one phase and will be full phase-to-phase voltage for the 
other two phases. This is done for protective purposes.

FIGURE 2–7: Three-phase voltage and current phasors for delta winding

Another common delta connection is the four-wire, grounded delta used for lighting loads. 
In this connection the center point of one winding is grounded. On a 120/240 volt, four-
wire, grounded delta service the phase-to-ground voltage would be 120 volts on two 
phases and 208 volts on the third phase. The phasor diagram for the voltages in a three-
phase, four-wire delta system is shown below.
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FIGURE 2–8: Three-phase, four-wire delta phasors

2.6.4 Blondell's Theorem and Three-phase Measurement
In 1893 an engineer and mathematician named Andre E. Blondell set forth the first 
scientific basis for poly phase metering. His theorem states:

If energy is supplied to any system of conductors through N wires, the total power in 
the system is given by the algebraic sum of the readings of N wattmeters so 
arranged that each of the N wires contains one current coil, the corresponding 
potential coil being connected between that wire and some common point. If this 
common point is on one of the N wires, the measurement may be made by the use 
of N-1 wattmeters.

The theorem may be stated more simply, in modern language:

In a system of N conductors, N – 1 meter elements will measure the power or 
energy taken provided that all the potential coils have a common tie to the 
conductor in which there is no current coil.

Three-phase power measurement is accomplished by measuring the three individual 
phases and adding them together to obtain the total three phase value. In older analog 
meters, this measurement was made using up to three separate elements. Each element 
combined the single-phase voltage and current to produce a torque on the meter disk. All 
three elements were arranged around the disk so that the disk was subjected to the 
combined torque of the three elements. As a result the disk would turn at a higher speed 
and register power supplied by each of the three wires.

According to Blondell's Theorem, it was possible to reduce the number of elements under 
certain conditions. For example, a three-phase, three-wire delta system could be correctly 
measured with two elements (two potential coils and two current coils) if the potential coils 
were connected between the three phases with one phase in common.

In a three-phase, four-wire wye system it is necessary to use three elements. Three voltage 
coils are connected between the three phases and the common neutral conductor. A 
current coil is required in each of the three phases.
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In modern digital meters, Blondell's Theorem is still applied to obtain proper metering. The 
difference in modern meters is that the digital meter measures each phase voltage and 
current and calculates the single-phase power for each phase. The meter then sums the 
three phase powers to a single three-phase reading.

Some digital meters calculate the individual phase power values one phase at a time. This 
means the meter samples the voltage and current on one phase and calculates a power 
value. Then it samples the second phase and calculates the power for the second phase. 
Finally, it samples the third phase and calculates that phase power. After sampling all three 
phases, the meter combines the three readings to create the equivalent three-phase 
power value. Using mathematical averaging techniques, this method can derive a quite 
accurate measurement of three-phase power.

More advanced meters actually sample all three phases of voltage and current 
simultaneously and calculate the individual phase and three-phase power values. The 
advantage of simultaneous sampling is the reduction of error introduced due to the 
difference in time when the samples were taken.

Blondell's Theorem is a derivation that results from Kirchhoff's Law. Kirchhoff's Law states 
that the sum of the currents into a node is zero. Another way of stating the same thing is 
that the current into a node (connection point) must equal the current out of the node. The 
law can be applied to measuring three-phase loads. The figure below shows a typical 
connection of a three-phase load applied to a three-phase, four-wire service. Kirchhoff's 
Laws hold that the sum of currents A, B, C and N must equal zero or that the sum of 
currents into Node “n” must equal zero.

FIGURE 2–9: Three-phase load illustrating Kirchhoff’s law and Blondell’s theorem

If we measure the currents in wires A, B and C, we then know the current in wire N by 
Kirchhoff's Law and it is not necessary to measure it . This fact leads us to the conclusion of 
Blondell's Theorem that we only need to measure the power in three of the four wires if 
they are connected by a common node. In the circuit of Figure 1.6 we must measure the 
power flow in three wires. This will require three voltage coils and three current coils (a 
three element meter). Similar figures and conclusions could be reached for other circuit 
configurations involving delta-connected loads.
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2.7 Power, Energy, and Demand

2.7.1 Description
It is quite common to exchange power, energy, and demand without differentiating 
between the three. Because this practice can lead to confusion, the differences between 
these three measurements will be discussed.

2.7.2 Power
Power is an instantaneous reading. The power reading provided by a meter is the present 
flow of watts. Power is measured immediately just like current. In many digital meters, the 
power value is actually measured and calculated over a one-second interval, since it takes 
some amount of time to calculate the RMS values of voltage and current. However, this 
time interval is kept small to preserve the instantaneous nature of power.

2.7.3 Energy
Energy is always based upon some time increment – it is the integration of power over a 
defined time increment. Energy is an important value because almost all electric bills are 
based, in part, on the amount of energy consumed.

Typically, electrical energy is measured in units of kilowatt-hours (kWh). A kilowatt-hour 
represents a constant load of 1000 watts (1 kW) for 1 hour. Stated another way, if the 
power delivered (instantaneous watts) is measured as 1000 W, and the load was served for 
a one-hour time interval, then the load would have absorbed 1 kWh of energy. A different 
load may have a constant power requirement of 4000 W. If this load were served for one 
hour, it would absorb 4 kWh of energy. Likewise, if it were served for 15 minutes, it would 
absorb ¼ of that total, or 1 kWh.

The following figure shows a graph of power and the resulting energy that would be 
transmitted as a result of the illustrated power values. For this illustration, it is assumed 
that the power level is held constant for each minute when a measurement is taken. Each 
bar in the graph represents the power load for the one-minute increment of time. In real 
life, the power values are continually moving.
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FIGURE 2–10: Power use over time

The data in the above figure is reproduced in the following table to illustrate the 
calculation of energy. Since the time increment of the measurement is one minute, and 
since we specified a constant load over that minute, the power reading can be converted 
to an equivalent consumed energy reading by multiplying the power reading by 1/60 
(converting the time base from minutes to hours).
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As shown in the above table, the accumulated energy for the power load profile of the 
data in Power use over time on page 2–18 is 14.92 kWh.

2.7.4 Demand
Demand is also a time-based value. The demand is the average rate of energy use over 
time. The actual label for demand is kilowatt-hours/hour but this is normally reduced to 
kilowatts. This makes it easy to confuse demand with power. But demand is not an 
instantaneous value. To calculate demand it is necessary to accumulate the energy 
readings (as illustrated in Power use over time on page 2–18) and adjust the energy 
reading to an hourly value that constitutes the demand.

In the above example, the accumulated energy is 14.92 kWh. But this measurement was 
made over a 15-minute interval. To convert the reading to a demand value, it must be 
normalized to a 60-minute interval. If the pattern were repeated for an additional three 15-
minute intervals the total energy would be four times the measured value or 59.68 kWh. 
The same process is applied to calculate the 15-minute demand value. The demand value 
associated with the example load is 59.68 kWh/hour or 59.68 kWd. Note that the peak 
instantaneous value of power is 80 kW, significantly more than the demand value.

The following figure illustrates another example of energy and demand. In this case, each 
bar represents the energy consumed in a 15-minute interval. The energy use in each 
interval typically falls between 50 and 70 kWh. However, during two intervals the energy 

Table 2–2: Power and energy relationship over time

Time Interval Power Energy Accumulated 
Energy

1 minute 30 kW 0.50 kWh 0.50 kWh

2 minutes 50 kW 0.83 kWh 1.33 kWh

3 minutes 40 kW 0.67 kWh 2.00 kWh

4 minutes 55 kW 0.92 kWh 2.92 kWh

5 minutes 60 kW 1.00 kWh 3.92 kWh

6 minutes 60 kW 1.00 kWh 4.92 kWh

7 minutes 70 kW 1.17 kWh 6.09 kWh

8 minutes 70 kW 1.17 kWh 7.26 kWh

9 minutes 60 kW 1.00 kWh 8.26 kWh

10 minutes 70 kW 1.17 kWh 9.43 kWh

11 minutes 80 kW 1.33 kWh 10.76 kWh

12 minutes 50 kW 0.83 kWh 12.42 kWh

13 minutes 50 kW 0.83 kWh 12.42 kWh

14 minutes 70 kW 1.17 kWh 13.59 kWh

15 minutes 80 kW 1.33 kWh 14.92 kWh



2–20 EPM 9800 ADVANCED POWER QUALITY METERING SYSTEM – USER GUIDE

ELECTRICAL BACKGROUND CHAPTER 2: ELECTRICAL BACKGROUND

rises sharply and peaks at 100 kWh in interval #7. This peak of usage will result in setting a 
high demand reading. For each interval shown the demand value would be four times the 
indicated energy reading. So interval 1 would have an associated demand of 240 kWh/hr. 
Interval #7 will have a demand value of 400 kWh/hr. In the data shown, this is the peak 
demand value and would be the number that would set the demand charge on the utility 
bill.

FIGURE 2–11: Energy use and demand intervals

As seen in this example, it is important to recognize the relationships between power, 
energy and demand to effectively control loads or to correctly monitor use.
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2.8 Reactive Energy and Power Factor

2.8.1 Real, Reactive, and Apparent Power
The real power and energy measurements discussed in the previous section relate to the 
quantities that are most used in electrical systems. But it is often not sufficient to only 
measure real power and energy. Reactive power is a critical component of the total power 
picture because almost all real-life applications have an impact on reactive power. 
Reactive power and power factor concepts relate to both load and generation 
applications. However, this discussion will be limited to analysis of reactive power and 
power factor as they relate to loads. To simplify the discussion, generation will not be 
considered.

Real power (and energy) is the component of power that is the combination of the voltage 
and the value of corresponding current that is directly in phase with the voltage. However, 
in actual practice the total current is almost never in phase with the voltage. Since the 
current is not in phase with the voltage, it is necessary to consider both the in-phase 
component and the component that is at quadrature (angularly rotated 90° or 
perpendicular) to the voltage. The following figure shows a single-phase voltage and 
current and breaks the current into its in-phase and quadrature components.

Figure 2-1: Voltage and complex current

The voltage (V) and the total current (I) can be combined to calculate the apparent power 
or VA. The voltage and the in-phase current (IR) are combined to produce the real power or 
watts. The voltage and the quadrature current (IX) are combined to calculate the reactive 
power. 

The quadrature current may be lagging the voltage (as shown above) or it may lead the 
voltage. When the quadrature current lags the voltage the load is requiring both real 
power (watts) and reactive power (vars). When the quadrature current leads the voltage 
the load is requiring real power (watts) but is delivering reactive power (vars) back into the 
system; that is vars are flowing in the opposite direction of the real power flow.

Reactive power (vars) is required in all power systems. Any equipment that uses 
magnetization to operate requires vars. Usually the magnitude of vars is relatively low 
compared to the real power quantities. Utilities have an interest in maintaining var 
requirements at the customer to a low value to maximize the return on plant invested to 
deliver energy. When lines are carrying vars, they cannot carry as many watts. So keeping 
the var content low allows a line to carry its full capacity of watts. To encourage customers 
to keep var requirements low, most utilities impose a penalty if the var content of the load 
rises above a specified value.
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2.8.2 Power Factor
A common method of measuring reactive power requirements is power factor. Power 
factor can be defined in two different ways. The more common method of calculating 
power factor is the ratio of the real power to the apparent power. This relationship is 
expressed in the following formula:

 (EQ 2.28)

This formula calculates a power factor quantity known as total power factor. It is called 
total PF because it is based on the ratios of the power delivered. The delivered power 
quantities will include the impacts of any existing harmonic content. If the voltage or 
current includes high levels of harmonic distortion the power values will be affected. By 
calculating power factor from the power values, the power factor will include the impact of 
harmonic distortion. In many cases this is the preferred method of calculation because the 
entire impact of the actual voltage and current are included.

A second type of power factor is displacement power factor. Displacement PF is based on 
the angular relationship between the voltage and current. Displacement power factor 
does not consider the magnitudes of voltage, current or power. It is solely based on the 
phase angle differences. As a result, it does not include the impact of harmonic distortion. 
Displacement power factor is calculated using the following equation:

 (EQ 2.29)

where θ is the angle between the voltage and the current (see Figure 2-1: Voltage and 
complex current on page 2–21).

In applications where the voltage and current are not distorted, the total power factor will 
equal the displacement power factor. But if harmonic distortion is present, the two power 
factors will not be equal.

Total PF real power
apparent power
---------------------------------------- watts

VA
--------------= =

Displacement PF θcos=
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2.9 Harmonic Distortion

2.9.1 Harmonics of a Non-sinusoidal Waveform
Harmonic distortion is primarily the result of high concentrations of non-linear loads. 
Devices such as computer power supplies, variable speed drives and fluorescent light 
ballasts make current demands that do not match the sinusoidal waveform of AC 
electricity. As a result, the current waveform feeding these loads is periodic but not 
sinusoidal. The following figure shows a normal, sinusoidal current waveform with a period 
of a. This example has no distortion.

FIGURE 2–12: Non-distorted current waveform

The figure below shows a current waveform with a slight amount of harmonic distortion. 
The waveform is still periodic and is fluctuating at the normal 60 Hz frequency (a = 1/60 
second). However, the waveform is not the smooth sinusoidal form seen above.

FIGURE 2–13: Distorted current waveform

The distortion above can be modeled as the sum of several sinusoidal waveforms of 
frequencies that are multiples of the fundamental 60 Hz frequency. This modeling is 
performed by mathematically reducing the distorted waveform into a collection of higher 

–1000

–500

0

500

1000

t

C
ur

re
nt

 (a
m

ps
)

a 2a

–1000

–500

0

500

1000

t

C
ur

re
nt

 (a
m

ps
)

a 2a

–1500

1500



2–24 EPM 9800 ADVANCED POWER QUALITY METERING SYSTEM – USER GUIDE

ELECTRICAL BACKGROUND CHAPTER 2: ELECTRICAL BACKGROUND

frequency waveforms. These higher frequency waveforms are referred to as harmonics. 
The following figure shows the content of the harmonic frequencies that comprise one 
cycle of the distorted portion of the above waveform.

FIGURE 2–14: Harmonics for distorted current waveform

The waveforms above provide an indication of the impact of combining multiple harmonic 
frequencies together. The broken lines represent the 3rd, 5th, and 7th current harmonics. 
The solid line represents the sum of the three harmonics.

When harmonics are present, it is important to remember that they are operating at 
higher frequencies. As such, they do not always respond in the same manner as 60 Hz 
values.

2.9.2 Inductive and Capacitive Impedance
Inductive and capacitive impedance are present in all power systems. We are accustomed 
to thinking about these impedances as they perform at 60 Hz. However, these impedances 
are subject to frequency variation.

 (EQ 2.30)

At 60 Hz, ω = 377; but at 300 Hz (5th harmonic) ω = 1885. As frequency changes, the 
impedance changes and system impedance characteristics that are normal at 60 Hz may 
be entirely different in the presence of higher order harmonic waves.

Traditionally, the most common harmonics have been the low order odd frequencies, such 
as the 3rd, 5th, 7th, and 9th. However newer, non-linear loads are introducing significant 
quantities of higher order harmonics.

2.9.3 Voltage and Current Monitoring
Since much voltage monitoring and almost all current monitoring is performed using 
instrument transformers, the higher order harmonics are often not visible. Instrument 
transformers are designed to pass 60 Hz quantities with high accuracy. These devices, 
when designed for accuracy at low frequency, do not pass high frequencies with high 
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accuracy; at frequencies above about 1200 Hz they pass almost no information. So when 
instrument transformers are used, they effectively filter out higher frequency harmonic 
distortion making it impossible to see.

However, when monitors can be connected directly to the measured circuit (such as direct 
connection to a 480 V bus) the user may often see higher order harmonic distortion. An 
important rule in any harmonics study is to evaluate the type of equipment and 
connections before drawing a conclusion. Not being able to see harmonic distortion is not 
the same as not having harmonic distortion.

2.9.4 Waveform Capture
It is common in advanced meters to perform a function commonly referred to as 
waveform capture. Waveform capture is the ability of a meter to capture a present picture 
of the voltage or current waveform for viewing and harmonic analysis. Typically a 
waveform capture will be one or two cycles in duration and can be viewed as the actual 
waveform, as a spectral view of the harmonic content, or a tabular view showing the 
magnitude and phase shift of each harmonic value. Data collected with waveform capture 
is typically not saved to memory. Waveform capture is a real-time data collection event.

Waveform capture should not be confused with waveform recording that is used to record 
multiple cycles of all voltage and current waveforms in response to a transient condition.
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2.10 Power Quality

2.10.1 Description
Power quality can mean several different things. The terms power quality and power 
quality problem have been applied to all types of conditions. A simple definition of power 
quality problem is any voltage, current or frequency deviation that results in misoperation 
or failure of customer equipment or systems. The causes of power quality problems vary 
widely and may originate in the customer equipment, in an adjacent customer facility or 
with the utility.

In his book Power Quality Primer, Barry Kennedy provided information on different types of 
power quality problems. Some of that information is summarized in the following table.

It is often assumed that power quality problems originate with the utility. While it is true 
that many power quality problems can originate with the utility system, many problems 
originate with customer equipment. Customer-caused problems may manifest themselves 
inside the customer location or they may be transported by the utility system to another 
adjacent customer. Often, equipment that is sensitive to power quality problems may in 
fact also be the cause of the problem.

If a power quality problem is suspected, it is generally wise to consult a power quality 
professional for assistance in defining the cause and possible solutions to the problem.

Table 2–3: Typical power quality problems

Cause Disturbance Type Source(s)

Impulse 
transient

Transient voltage disturbance, sub-
cycle duration

Lightning;
Electrostatic discharge;
Load switching;
Capacitor switching

Oscillatory 
transient with 
decay

Transient voltage, sub-cycle duration Line/cable switching;
Capacitor switching;
Load switching

Sag/swell RMS voltage, multiple cycle duration Remote system faults

Interruptions RMS voltage, multiple second or 
longer duration

System protection;
Circuit breakers;
Fuses;
Maintenance

Undervoltage/
Overvoltage

RMS voltage, steady state, multiple 
second or longer duration

Motor starting;
Load variations;
Load dropping

Voltage flicker RMS voltage, steady state, repetitive 
condition

Intermittent loads;
Motor starting;
Arc furnaces

Harmonic 
distortion

Steady-state current or voltage, long 
term duration

Non-linear loads;
System resonance
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EPM 9800 Advanced Power Quality 
Metering System

Chapter 3: Installation

GE Consumer & Industrial
Multilin

Installation

3.1 Hardware Installation

3.1.1 Mounting the EPM 9800
The EPM 9800 Advanced Power Quality Metering System is designed to mount into a 
standard meter socket for forms 9S, 36S, and 45S. The EPM 9800 can be mounted outside 
or in an enclosed and protected environment, such as in a switchgear cabinet. A switch or 
circuit breaker can be installed nearby labeled as the EPM 9800 disconnecting mechanism. 
The dimensions for the standard meter are shown below.

Figure 3-1: Mounting dimensions (standard meter)
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The form 9A meter is designed to mount into an A-base terminal block. The dimensions for 
the A-base meter are shown below.

Figure 3-2: Mounting dimensions (A-base meter)

The form SB meter is designed to mount into an switchboard unit. The dimensions for the 
switchboard meter are shown below.

Figure 3-3: Mounting dimensions (switchboard meter)

3.1.2 Installing the Standard Meter
A summary of the EPM 9800 installation procedure is given below.

Examine the labels to verify the form and service type. Ensure that 
the socket and meter current class ratings are compatible.

Ensure that all communication and auxiliary power wiring is 
accessible in case disconnection is required.

Before applying power to the meter, install batteries and verify the 
connections. 
POWER MUST BE OFF TO INSTALL THE INTERNAL BATTERY! 
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To install the internal battery,

• Remove the internal shroud and place the battery into its 
compartment with the positive terminal (+) facing UP. Replace the 
internal shroud. Refer to Figure 3-7: Battery holder detail on page 
3–7.

To install the modem battery, 

• Keep the outer shroud on the meter and locate the battery cable 
at the back of the meter. 

• Insert the cable connector into the cable and use the velcro (peel 
and stick) to attach the battery somewhere outside of the meter.

Measure the enclosure to ensure it accommodates the meter (if the 
enclosure is a standard size, this step is not necessary).

Ensure that communications wiring from the back of the meter is 
fed through the appropriate openings to allow for clean 
connections with external devices.

Insert the meter into the socket, making sure that the unit blades 
are firmly within the jaws of the socket.

Connect external devices to the appropriate communications 
wiring. 
See the following figure and table for communications wiring 
details. RJ-11 and RJ-45 connectors will be supplied.

Figure 3-4: EPM 9800 rear view with communications wiring

Cable 2
high-speed
inputs

Cable 3
optional KYZ cable

Cable 1
port 1, port4, IRIG-B

Cable 8
optional auxiliary

power cable

OPTIONAL COMMUNICATIONS
1. Combination Modem/Ethernet:

2. Modem

3. Ethernet

Cable 4 - RS485 gateway
Cable 5 - RJ11 modem
Cable 6 - RJ45 Ethernet

Cable 4 - RS485 gateway
Cable 5 - RJ11 modem
Cable 7 - battery

Cable 6 - RJ45 Ethernet
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Make sure the meter is functioning properly by running it through a 
test circuit.

Note Cable colors are subject to change without notice. Refer to the cable labels for color 
code verification.

3.1.3 Installing the Switchboard Meter
The EPM 9800 switchboard meter allows for two-step installation or disconnection.

The switchboard cases are not exactly identical. They are welded together and as such 
have slight variations. For this reason, a tolerance (1/16-inch or 1.5875 mm) has been 
added to the cutout diagram below.

Ensure that the drill holes are checked for the mounting screws. Ensure that the mounting 
screw fits the box tightly enough to hold the box in place. If the mounting screw is slightly 
smaller than the drill holes, a washer may be used.

Table 3–1: Cable color key

Cable Signal Color Cable Signal Color

1 RS485 port 1 shield Black 3 KYZ normally closed 1 Black

RS485 port 1 Tx/Rx+ Brown KYZ common 1 Brown

RS485 port 1 Tx/Rx– Red KYZ normally open 1 Red

RS485 port 4 shield Orange KYZ normally closed 2 Orange

RS485 port 4 Tx/Rx+ Yellow KYZ common 2 Yellow

RS485 port 4 Tx/Rx– Green KYZ normally open 2 Green

IRIG-B + Blue KYZ normally closed 3 Blue

IRIG-B – Purple KYZ common 3 Purple

2 High speed input 8 Black KYZ normally open 3 Gray

High speed input 7 Brown KYZ normally closed 4 Lt. Grn

High speed input 6 Red KYZ common 4 Pink

High speed input 5 Orange KYZ normally open 4 White

High speed input 4 Yellow 4 RS485 gateway shield Blue

High speed input 3 Green RS485 gateway Tx/Rx+ Green

High speed input 2 Blue RS485 gateway Tx/Rx– Red

High speed input 1 Gray 5 RJ11 modem Blue

Common Purple 6 RJ45 Ethernet Blue

7 Battery Black

8 Auxiliary power + Brown

Auxiliary power – Blue



CHAPTER 3: INSTALLATION INSTALLATION

EPM 9800 ADVANCED POWER QUALITY METERING SYSTEM – USER GUIDE 3–5

Figure 3-5: Switchboard meter cutout

Insert the case into a prepared mounting hole for the switchboard 
case. 

Secure with mounting screws.

Before installing the meter, check the battery connections (see 
Battery Installation and Maintenance on page 3–6).

Slide the meter into the case.

Secure by sliding the chassis levers until they snap into place.

Connectors for the following items are located on the back of the meter. The 
connectors will automatically plug into the available connectors on the mounting 
board.

Pulse outputs (four channels)
Status inputs
Phone
Line/network
Power in
COM4 - COM1 - IRIG-B
RS485 modem gateway

Position the case front against the four screw holes. 

Secure the front of the case by turning the four built-in screws in 
each of the corners.

6.125" ±0.0625"
(155.575mm ±1.5875mm)

5.56" ±0.0625"
(141.22mm ±1.5875mm)

#10-32 mounting screw
0.20" ( 5.08mm)∅∅

(typ. 4X)

2.1875"
±0.031"

(55.56mm
±0.7874)

4.375" ±0.0625"
(111.125mm ±1.5875mm)

0.25" (6.35mm)
2.78" ±0.031"

(70.612mm ±0.7874mm)

8.0625" ±0.0625"
(204.788mm ±1.5875mm)
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3.1.4 Battery Installation and Maintenance
The internal battery is a 3 V Lithium battery (Panasonic BR2032 or equivalent) that 
maintains NVRAM and time during outages. It is located on one of the vertical panels inside 
the internal shroud (see the figure below). Under normal conditions, the battery should 
provide in excess of 10 years of service during storage conditions (disconnected from 
terminals) or when properly installed in an energized meter. The battery should provide 
more than one year of service during outage conditions (time on battery backup). A low 
battery indicator provides notification when a replacement is needed.

Figure 3-6: EPM 9800 without internal shroud

Battery installation or replacement must be done with power off!

The following procedure describes how to change the battery (see fig 3-7).

Before replacing a battery, download all memory files to a local 
computer. 
Note that data may be lost.

Remove power from the meter.

Remove the external meter cover and the internal shroud.

Remove the old battery with a screwdriver or similar tool.

Make sure the + on the new battery is facing up and outwards.

Insert the right side of the battery under the two clips on the right 
side of the holder while gently pushing the battery against the 
inside right wall of the battery holder (arrow A).

Gently push the left side of the battery in until it snaps into place 
(arrow B).

Internal
battery
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Figure 3-7: Battery holder detail

Note It is very important to correctly insert the replacement battery into the holder. Otherwise 
proper contact will not be achieved and the meter may lose memory and time functions.

Replace the internal shroud and the external meter cover.

Energize the meter.

Reset Time using Communicator software. If IRIG-B is connected, 
time is synchronized automatically.

Note For battery safety and disposal, ensure the recommendations below are followed.

• Do not expose battery to temperatures above 100°C. Do not incinerate, puncture, 
crush, recharge, short-circuit or over-discharge battery.

• Do not expose contents of battery to water or to high humidity for extended 
periods of time.

• Dispose of batteries in accordance with local, state and federal hazardous waste 
regulations.

3.1.5 Input/Output Module Mounting
Connect multiple input/output modules by inserting male RS485 
side ports into female ports.

Using a flathead screwdriver, screw each module into the next. 
Work from left to right. 

If multiple input/output modules are connected together, as shown 
in Figure 3-8: Input/output modules mounting (overhead view), or 
an individual module is used, secure the mounting brackets to both 
ends of the group (or individual module) using the screws supplied 
(#440 pan-head screws).

Secure the brackets to a flat surface using a #8 screw with a lock 
washer.
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Note The EPM 9800 does not supply power for the input/output modules. An external power 
supply, such as the PSIO (12 V output), must be used. The following figure shows the input/
output modules mounted without a PSIO power supply; refer to Figure 3-11: Input/output 
modules with PSIO mounting (front view) on page 3–9 for mounting with the PSIO.

Figure 3-8: Input/output modules mounting (overhead view)

Figure 3-9: Input/output modules mounting (front view)

3 x 1.32" (33.27mm)

1.13" (28.57mm)

0.015" (0.37mm)

mounting bracket

mounting bracket

4.1" (104.14mm)

mounting bracket (MBIO)

1.25" (31.75mm) + Y
per module

mounting bracket (MBIO)

2 x 1.10"
(27.93mm)

Y = 1.13"
(31.37mm)

2.20" (55.87mm) 3.44"
(87.38mm)
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Figure 3-10: Input/output module communication ports

Figure 3-11: Input/output modules with PSIO mounting (front view)

mouting brackets (MBIO)

female RS485
side port

input/output
port

male RS485
side port

1.25" (31.75mm) +Y per module
+ X per PSIO

mounting
bracket (MBIO)

mounting
bracket (MBIO)

2 x 1.10"
(27.93mm)

Y = 1.31"
(31.37mm)

X = 1.73"
(43.94mm)

2.20"
(55.87mm)

3.44"
(87.38mm)
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3.2 Electrical Installation

3.2.1 Wiring Diagrams
Corresponding wiring diagrams for the various EPM 9800 forms appear on the following 
pages. If the required connection is not shown, contact GE Multilin for a custom connection 
diagram.

Note Grounding: Industrial meters are typically grounded at the service entrance (not the meter) 
per NEC (1999) section 250-24(5) and 250-26.

Note Auxiliary power: Meters may be externally powered using a 120 to 230 V AC or 
125 to 400 V DC power supply.

The associated forms and wiring types are shown in the following table.

Table 3–2: EPM 9800 forms and associated wiring types

Form Wiring description Figures Page(s)

standard switchboard

9S Wye, no PTs, 3 CTs 3-12 3-13 3–11, 3–12

Wye, 3 PTs, 3 CTs 3-14 3-15 3–13, 3–14

4-wire delta, no PTs, 3 CTs 3-16 3-17 3–15, 3–16

4-wire delta, 3 PTs, 3 CTs 3-18 3-19 3–17, 3–18

4-wire delta, no PTs, 2 CTs 3-20 3-21 3–19, 3–20

4-wire delta, 2 PTs, 2 CTs 3-22 3-23 3–21, 3–22

3-wire delta, no PTs, 2 CTs 3-24 3-24 3–23, 3–23

3-wire delta, 2 PTs, 2 CTs 3-26 3-27 3–25, 3–26

36S 2.5 element wye, no PTs, 3 CTs 3-28 3-29 3–27, 3–28

2.5 element wye, 2 PTs, 3 CTs 3-30 3-31 3–29, 3–30

45S Wye, no PTs, 3 CTs 3-32 --- 3–31

Wye, 2 PTs, 3 CTs 3-33 --- 3–32

3-wire delta, no PTs, 3 CTs 3-34 --- 3–33

3-wire delta, 2 PTs, 2 CTs 3-35 --- 3–34

4-wire delta, no PTs, 2 CTs 3-36 --- 3–35

4-wire delta, 2 PTs, 2 CTs 3-37 --- 3–36
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The wiring diagram for form 9S (transformer rated) wye, 4-wire, with no PTs and 3 CTs for 
the standard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-12: Form 9S wye, no PTs, 3 CTs wiring (standard meter)
709730A1.CDR

V3 NV1

LINE

V2

N

I1

I2

2

3

LOAD

V1

I3

N
1

V3

V2
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The wiring diagram for form 9S (transformer rated) wye, 4-wire, with no PTs and 3 CTs for 
the switchboard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-13: Form 9S wye, no PTs, 3 CTs wiring (switchboard meter)

709731A1.CDR

LINE

LOAD
N 23 1

I3

I2

I1

V1

V2

V3

N

3

2

1
N

CTs

709731A1.CDR
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The wiring diagram for form 9S (transformer rated) wye, 4-wire, with 3 PTs and 3 CTs for 
the standard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-14: Form 9S wye, 3 PTs, 3 CTs wiring (standard meter)
709732A1.CDR

2

3

LOAD

V1V2

LINE

N

V3

V1

1

V2

I1

I2

I3

V3

N
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The wiring diagram for form 9S (transformer rated) wye, 4-wire, with 3 PTs and 3 CTs for 
the switchboard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-15: Form 9S wye, 3 PTs, 3 CTs wiring (switchboard meter)

709733A1.CDR

LINE

CTs

3

2

1
N

I3

I2

I1

V1

V2

V3

N

PTs

N 3 2 1
LOAD
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The wiring diagram for form 9S (transformer rated) delta, 4-wire, with no PTs and 3 CTs for 
the standard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-16: Form 9S 4-wire delta, no PTs, 3 CTs wiring (standard meter)
709734A1.CDR

N 2 1

3

N
V2

LINE

V1
N

I1

I2

I3

V3

LOAD

V2

V3 V1
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The wiring diagram for form 9S (transformer rated) delta, 3-wire, with no PTs and 3 CTs for 
the switchboard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-17: Form 9S 3-wire delta, no PTs, 3 CTs wiring (switchboard meter)

709735A1.CDR

3

2 1

N

LINE

LOAD

3 2 1 N

CTs

I3

I2

I1

V1

V2

V3

N
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The wiring diagram for form 9S (transformer rated) delta, 4-wire, with 3 PTs and 3 CTs for 
the standard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-18: Form 9S 4-wire delta, 3 PTs, 3 CTs wiring (standard meter)
709736A1.CDRLOAD

V1V2

LINE

N

V3´

V1´

V2´

I1

I2

I3

V3
2 1

3

N

N´
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The wiring diagram for form 9S (transformer rated) delta, 4-wire, with 3 PTs and 3 CTs for 
the switchboard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-19: Form 9S 4-wire delta, 3 PTs, 3 CTs wiring (switchboard meter)

709737A1.CDR

LINE

CTs

3

2 1

N

I3

I2

I1

V1

V2

V3

N

PTs

N 3 2 1
LOAD
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The wiring diagram for form 9S (transformer rated) delta, 3-wire, with no PTs and 2 CTs for 
the standard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-20: Form 9S 3-wire delta, no PTs, 2 CTs wiring (standard meter)
709738A1.CDR

2 1

3

N
V2

LINE

V1

I1

I3

V3

LOAD

V3 V1

V2
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The wiring diagram for form 9S (transformer rated) delta, 3-wire, with no PTs and 2 CTs for 
the switchboard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-21: Form 9S 3-wire delta, no PTs, 2 CTs wiring (switchboard meter)
709739A1.CDR

3

2 1
N

LINE

LOAD
3 2 1

CTs

I3

I2
I1

V1
V2
V3
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The wiring diagram for form 9S (transformer rated) delta, 3-wire, with 2 PTs and 2 CTs for 
the standard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-22: Form 9S 3-wire delta, 2 PTs, 2 CTs wiring (standard meter)
709740A1.CDRLOAD

V1V2

LINE

V3´

V2´

I1

I3

V3
2 1

3

N

V1´
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The wiring diagram for form 9S (transformer rated) delta, 3-wire, with 2 PTs and 2 CTs for 
the switchboard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-23: Form 9S 3-wire delta, 2 PTs, 2 CTs wiring (switchboard meter)

709741A1.CDR

LINE

CTs

3

2 1

N

I3

I2

I1

V1

V3

V2

PTs

3 2 1
LOAD
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The wiring diagram for form 9S (transformer rated) delta, 3-wire, with no PTs and 2 CTs for 
the standard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-24: Form 9S 3-wire delta, no PTs, 2 CTs wiring (standard meter)
709742A1.CDR

2 1

3

V2

LINE

V1

I1

I3

V3

LOAD

V3 V1

V2
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The wiring diagram for form 9S (transformer rated) delta, 3-wire, with no PTs and 2 CTs for 
the switchboard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-25: Form 9S 3-wire delta, no PTs, 2 CTs wiring (switchboard meter)
709743A1.CDR

3

2 1
N
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LOAD
3 2 1
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I3
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The wiring diagram for form 9S (transformer rated) delta, 3-wire, with 2 PTs and 2 CTs for 
the standard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-26: Form 9S 3-wire delta, 2 PTs, 2 CTs wiring (standard meter)
709744A1.CDRLOAD

V1V2

LINE

V3´
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I1

I3

V3
2 1

3
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The wiring diagram for form 9S (transformer rated) delta, 3-wire, with 2 PTs and 2 CTs for 
the switchboard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-27: Form 9S 3-wire delta, 2 PTs, 2 CTs wiring (switchboard meter)

709745A1.CDR
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CTs

3

2 1
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The wiring diagram for form 36S (transformer rated) wye, 2.5-element, with no PTs and 3 
CTs for the standard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-28: Form 36S 2.5-element wye, no PTs, 3 CTs wiring (standard meter)
709746A1.CDR
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The wiring diagram for form 36S (transformer rated) wye, 2.5-element, with no PTs and 3 
CTs for the switchboard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-29: Form 36S 2.5-element wye, no PTs, 3 CTs wiring (switchboard meter)

709747A1.CDR
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The wiring diagram for form 36S (transformer rated) wye, 2.5-element, with 2 PTs and 3 
CTs for the standard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-30: Form 36S 2.5-element wye, 2 PTs, 3 CTs wiring (standard meter)
709748A1.CDR
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The wiring diagram for form 36S (transformer rated) wye, 2.5-element, with 2 PTs and 3 
CTs for the switchboard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-31: Form 36S 2.5-element wye, 2 PTs, 3 CTs wiring (switchboard meter)
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The wiring diagram for form 45S (transformer rated) wye, 4-wire, with no PTs and 3 CTs for 
the standard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-32: Form 45S 4-wire wye, no PTs, 3 CTs wiring (standard meter)
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The wiring diagram for form 45S (transformer rated) wye, 4-wire, with 2 PTs and 3 CTs for 
the standard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-33: Form 45S 4-wire wye, 2 PTs, 3 CTs wiring (standard meter)
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The wiring diagram for form 45S (transformer rated) delta, 3-wire, with no PTs and 2 CTs for 
the standard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-34: Form 45S 3-wire delta, no PTs, 2 CTs wiring (standard meter)
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The wiring diagram for form 45S (transformer rated) delta, 3-wire, with 2 PTs and 2 CTs for 
the standard meter is shown below.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-35: Form 45S 3-wire delta, 2 PTs, 2 CTs wiring (standard meter)
709757A1.CDR
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The wiring diagram for form 45S (transformer rated) delta, 4-wire, with no PTs and 2 CTs for 
the standard meter is shown below. Neutral is not shown for simplicity.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-36: Form 45S 4-wire delta, no PTs, 2 CTs wiring (standard meter)
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The wiring diagram for form 45S (transformer rated) delta, 4-wire, with 2 PTs and 2 CTs for 
the standard meter is shown below. Neutral is not shown for simplicity.

Note Actual installation procedures, materials, equipment, and connections must conform to 
applicable codes and standards.

Figure 3-37: Form 45S 4-wire delta, no PTs, 2 CTs wiring (standard meter)
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3.2.2 Input/Output Module Wiring
The EPM 9800 will not supply power for the input/output modules. An additional power 
supply, such as the PSIO, must be used. The wiring is the same for all modules.

Figure 3-38: Input/output pin detail

Input/output modules must use the EPM 9800 port 4. Six feet of RS485 cable harness is 
supplied. Attach one end of the cable to the port (connectors may not be supplied); insert 
the other end into the communication pins of the module RS485 side port (see details 
below).

Figure 3-39: EPM 9800 connected to input/output module

PWR+
PWR–
SHIELD
B(–)
A(+)

Auxiliary power is supplied
through pins 4 and 5

Connection through
SHIELD, B–, and A+ to
the EPM 9800 port 4
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3.2.3 High-speed Inputs Wiring
The high-speed inputs can be used in multiple ways:

1. By attaching the KYZ pulse outputs from other meters for pulse counting and 
totalizing.

2. By attaching status contacts from relays, breakers or other devices for status or 
waveform initiation.

Figure 3-40: High speed inputs connection
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3.2.4 IRIG-B Wiring
IRIG-B is a standard time code format that synchronizes event time stamping to within 
1 ms. An IRIG-B signal-generating device connected to the GPS satellite system will 
synchronize EPM 9800 meters located at different geographic locations. The meter utilizes 
an unmodulated signal from a satellite-controlled clock. For details on installation, refer to 
the instruction manual for the satellite-controlled clock in use.

Figure 3-41: IRIG-B connection

Use the following procedure to install IRIG-B:

Set the EPM 9800 time settings from the GE Communicator EXT 
software by selecting the Time Settings item in the device profile. 

Set the time zone and daylight savings time then update the device 
profile to save the new settings.

GPS satellite connection

IRIG-B time
signal generating
device

IRIG-B port
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Before connection, ensure that the date on the satellite clock is 
correct (or, within 2 months of the actual date). 
This provides the correct year for the clock (the GPS does not 
supply the year).

Connect the positive (+) terminal of the meter to the positive (+) 
terminal of the signal generating device.

Likewise, connect the negative (–) terminal of the meter to the 
negative (–) terminal of the signal generating device.

The most common source of problems with IRIG-B is a reversal of the positive and negative 
wires. Try reversing the wires if problems occur.



EPM 9800 ADVANCED POWER QUALITY METERING SYSTEM – USER GUIDE 4–1

EPM 9800 Advanced Power Quality 
Metering System

Chapter 4: Operating Instructions

GE Consumer & Industrial
Multilin

Operating Instructions

4.1 Nameplate Information

4.1.1 Faceplate
The EPM 9800 Advanced Power Quality Metering System has operating information 
represented on the nameplate, located on the face of the meter. See below for details.

Figure 4-1: EPM 9800 faceplate

The ratios and constants shown on the left side of the front panel include

• multiply by constant

• voltage transformer ratio (or PT ratio)

• current transformer ratio (or CT ratio)

• primary watt-hour constant

The power data shown on the bottom of the faceplate includes

• current class

• test current

• watt-hour test constant

Form factor
diagram

Mode switch

Ratios
and constants

Power data
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• ANSI C12.20 form number

• ANSI C12.20 accuracy class

4.1.2 Options Label
The options label is adhered to the outside of the internal shroud. It indicates the ordered 
options included in the meter. The label below is an example of a typical label.

Figure 4-2: EPM 9800 options label
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4.2 Basic Operations

4.2.1 Switches and Indicators
There are two switches accessible from outside the meter cover.

1. The mode switch (also called a reed switch) is used to switch from normal mode to 
circuit diagnostic mode or time of use mode.

2. The reset switch is used to reset demand.

A third switch, the test button, is accessible only when the cover has been removed. The 
test button switches the meter from one of the operational modes to test mode and back 
to normal mode. The test button is also used to access display adjustments mode during 
power up mode. The display adjustments mode is discussed in the next section.

The optical port is on the lower left side of the faceplate. The optical port facilitates infrared 
communication with the meter. Using a SC-3 smart coupler (or other ANSI C12.13 Type II 
magnetic optical communications coupler) and an RS232 cable from the smart coupler to 
a PC, the meter can be programmed with the GE Communicator EXT software.

An infrared test pulse is located on the upper left side of the faceplate. Energy pulsing 
applications can be configured using GE Communicator EXT.

A phase indicator is located on the lower right side of the faceplate. “ABC” will stay 
illuminated if all three phases of voltage and current are present. “ACB” indicates reversed 
phase sequence. It will blink A, B or C if one phase is not present. If all phases are not 
present, the meter will turn off (unless there is an auxiliary pigtail connected to a power 
source). 

4.2.2 Display Information
The EPM 9800 uses a graphical back-lit LCD programmable display with extended 
temperature voltage compensation. This allows viewing of energy data and the gathering 
of circuit diagnostic data such as voltage, current, harmonics, and phasor information.

A wide range of values can be defined for display using the user modes and screens in the 
programmable display and GE Communicator EXT software. Three view modes plus test 
mode and a select compensation screen allow tremendous flexibility in setting up the 
modes and the screens within the modes. View modes are user created with up to 16 
screens each, which display in auto sequence every 7 seconds. Most of the screens have a 
status bar across the bottom which displays the date, time and phase (if there are inputs). 
View mode 1 is the primary mode. The other modes will automatically return to view mode 
1 after a user-set amount of time from last user action.

• Low battery: The Lo Batt - NVRAM (internal battery) or Lo Batt - Modem (modem 
battery) message will flash on the screen being displayed every 10 to 15 seconds only 
when the internal (or modem) battery is running low or when it is not “clicked” into 
place properly. If the batteries are OK, no indicator will appear.

• Test mode: The following test modes are available.
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Wh test - Same as kWh screen, except in Wh instead of kWh;
VARh test - Same as kVAR screen, except in VARh (quadrants);
VAh test - Same as kVAh screen, except in VAh (quadrants);
Watt rolling demand test (delivered and received);
Watt block demand test (delivered and received)

• Initial display screens: The EPM 9800 is shipped with initial display screens, which will 
scroll on the display the meter is powered up. The initial display screens are a 
sampling of the many screens available for the programmable display, which is 
detailed in Programmable Display on page 4–8.

• Backlight: The backlight cannot be set to stay on indefinitely. It will turn off after the 
amount of time selected. One hour is the maximum setting. If the backlight has timed 
out and is off, press the mode switch once to turn on the backlight and redirect the 
screen automatically.

4.2.3 Time Synchronization
The following time synchronization methods are available:

• IRIG-B: All EPM 9800 meters are equipped to use IRIG-B for time sychronization. If IRIG-
B is connected, this form of time synchronization takes precedence over the internal 
clock. If the GPS signal is lost, the internal clock takes over time keeping at the precise 
moment the signal is lost.

• Line synchronization: All EPM 9800 meters are equipped with line synchronization, 
which may be enabled for use instead of IRIG-B. If line synchronization is enabled and 
power is lost, the internal clock takes over at the precise moment power is lost.

• Internal clock: All EPM 9800 meters are equipped with internal clocks, which can be 
used if IRIG-B is not connected and/or line synchronization is not enabled. If either of 
the above time sychronization tools fails, the internal clock will take over at the precise 
moment the synchronization tool in use fails.

4.2.4 Time-of-Use (TOU)
A time-of-use (TOU) usage structure takes into account the quantity of energy used and 
the time at which it was consumed. The EPM 9800 TOU function, available with the GE 
Communicator EXT software, is designed to accommodate a variety of programmable rate 
structures. EPM 9800 TOU accumulates data based on the time-scheme programmed into 
the EPM 9800 meter.

A EPM 9800 TOU calendar sets the parameters for TOU data accumulation. Up to twenty 
calendars can be stored in the meter, and an unlimited number of calendar files can be 
stored on a PC.

The EPM 9800 TOU calendar profile allows a programmable usage schedule – for example, 
“weekday,” “weekend,” “holiday” – for each day of the calendar year. Up to 16 time-of-use 
schedules can be created. Each TOU schedule divides the 24-hour day into fifteen-minute 
intervals from 00:00:00 to 23:59:59.

One of eight different programmable registers—e.g. “peak,” “off peak,” “shoulder peak”— 
may be applied to each fifteen-minute interval.

The EPM 9800 meter stores accumulations as follows:
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• on a seasonal basis, up to four seasons per year;

• on a monthly basis.

Seasonal and monthly accumulations may span one year into the next. Each season and 
month is defined by a programmable start/billing date, which is also the end-date of the 
prior season or month.

• A season ends at midnight of the day before the start of the next season.

• A month ends at midnight of the month’s billing day.

If the year ends and there is no new calendar, TOU accumulations will stop. If a calendar is 
present for the following year, TOU accumulations continue until the next monthly bill date 
or next start-of-season is reached. Accumulation can span into the following year. If no 
following year is present, the last accumulation for the year will end on 12:31:23:59:59.

The EPM 9800 stores accumulations for the prior time periods. When the end of a billing 
period is reached, the active period of time becomes frozen. The registers are then cleared 
and accumulations resume, using the next set of TOU schedules and register assignments 
from the stored calendar. Frozen and active accumulations are always available.

The GE Communicator EXT software retrieves TOU calendars from the EPM 9800 or from 
the computer’s hard drive for review and edit. A maximum of twenty yearly calendars can 
be stored in the EPM 9800 at any given time. These may be retrieved them one at a time; a 
new calendar can be stored while a current calendar is in use.

Accumulations do not stop during calendar updates. If a calendar is replaced while in use, 
the accumulations for the current period will continue until the set end date. At that point, 
the current time will become the new start time and the settings of the new calendar will 
be used. Reset the current accumulations if a calendar in use is replaced. A reset clears 
only the current accumulation registers. This causes the current accumulations to use the 
present date as the start and accumulate to the next new end date, which will be taken 
from the new calendar. Once stored, prior accumulations are always available and cannot 
be reset. Refer to the GE Communicator EXT User Manual for details on resetting TOU 
accumulations.

At the end of a defined period, current accumulations are stored, the registers are cleared 
and accumulations for the next period begin. When the year boundary is crossed, the 
second calendar, if present, is used. To retain continuity, a one year period is provided to 
replace the old calendar with one for the following year.

If required, daylight saving time must be enabled in the Time Settings area of the EPM 
9800 device profile. 

Select Auto DST, which sets daylight saving time automatically (for 
the United States ONLY). 

Otherwise, select User Defined.

Manually enter the desired dates for daylight saving time. Refer to 
the GE Communicator EXT User Manual for additional details.



4–6 EPM 9800 ADVANCED POWER QUALITY METERING SYSTEM – USER GUIDE

OPERATING INSTRUCTIONS CHAPTER 4: OPERATING INSTRUCTIONS

Figure 4-3: Time settings window

To set demand intervals, 

Select the Revenue & Energy Settings > Demand Integration 
Intervals item from the device profile and set the desired intervals. 

Click OK when complete.

Figure 4-4: Demand integration window

To set the cumulative demand type, 

Select the Revenue & Energy Settings > Cumulative Demand 
Type item from the device profile.

Select “Block Window” or “Rolling Window.”
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 Click OK when complete.

Figure 4-5: Cumulative demand type window



4–8 EPM 9800 ADVANCED POWER QUALITY METERING SYSTEM – USER GUIDE

OPERATING INSTRUCTIONS CHAPTER 4: OPERATING INSTRUCTIONS

4.3 Programmable Display

4.3.1 Overview
The programmable display has three configurable user modes with up to 16 screens each. 
The three modes are displayed in auto sequence every 7 seconds. Using the GE 
Communicator EXT software, the user can assign up to 16 screens to each mode and any 
of the available screens can be used in any mode.The user also assigns a three-digit label 
that names the mode. The three modes are:

• Configurable view mode 1 - replacing normal mode

• Configurable view mode 2 - replacing circuit diagnostic mode

• Configurable View mode 3 - replacing time-of-use mode

This feature is very user-friendly and enables the user to determine what data will be 
displayed and in what order. This feature highlights larger (0.56-inch) digits on many of the 
screens so that data displayed is much easier to read.

View mode 1 is the primary mode. The other user modes (view modes 2 and 3) are 
accessed by swiping the mode switch twice. Test mode is accessed by removing the cover 
(power must be off), powering up the meter and pushing the test button at any time.

View modes 2 and 3 will automatically return to view mode 1 after a user-set amount of 
time after the last user action. Test mode will automatically return to view mode 1 after an 
amount of time after the last user action with no energy accumulation (or) an amount of 
time after the last user action plus the demand interval with energy accumulation. The 
values for the amount of time after the last user action is set on the miscellaneous screen 
in the user inactivity time outs section. The programmable display can be edited through 
GE Communicator EXT even if the meter is not connected to the computer. Simply select 
the File > Open > EPM 9800 Programmable Display Profile menu item and navigate to 
the programming settings files (files ending an NDS extension).

See the GE Communicator EXT instruction manual for additional details on programming 
the EPM 9800 and retrieving data.
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The EPM 9800 programmable display navigation map is shown below.

Figure 4-6: EPM 9800 programmable display navigation map
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4.3.2 Programmable Display Setup
The procedure to setup the programmable display is as follows.

Select the Tools > Edit LCD Programmable Settings menu item to 
open the Device Display Programmable Settings window.

Click the Meter Display Mode Names tab.

Enter a three-letter label and a description for each of the three 
view modes.

Click the Screen Assignments tab then double-click on the screen 
the desired screen.

Enter up to 16 screens under each mode. 
The label for each mode will appear at the top of each column.
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Click on the Power and Energy Display tab.

Enter settings for power and energy. 
For the scale, select from units, kilo-units, and mega-units. In the 
Primary Power section, select the number of digits (4 to 9) and the 
decimal point location (0 to 3). Previews appear at the bottom of 
the screen.

The values on this screen control the display of energy related data. Take care to 
match the values on the display with those in the historical logs. These settings apply 
to VA-hours, ±watthours, ±varhours and var-hours (each quadrant) in the meter.

The user-programmable scale factor determines the quantity used in the energy 
registers. The scale factor applies to primary values only (secondary values are always 
in units) and is set to units, kilo-units or mega-units. The scale factor takes precedence 
over all other settings (i.e., all other settings are based on this setting).

The number of digits displayed can be set between 4 and 9. This setting controls the 
display and storage of digits displayed and sets the register rollover for all energy 
registers. For example, if the scale setting is mega-units and the number of digits 
displayed is 5, the display will show up to 99999 MW-hours and associated registers 
will rollover at 99999 MWhours.

Click on the Miscellaneous tab. The screen settings replace 
adjustments mode in the default profile.

image required
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Enter settings in the miscellaneous screen as follows.

For the Screen Settings section, select:

Back Light Level: 0 (Off) to 4 (brightest)
Back Light Time (backlight shuts off): 00 min., 30 sec. to 60 min., 00 sec.
Contrast: 0 (highest) to 7 (lowest)
Scroll Stop: Enabled or Disabled
Phasor Diagram Rotation: Clockwise or Counterclockwise
Demand Shown: Cumulative or Continuous Cumulative
Time of Use Demand: Block/Rolling or Cumulative
Date Format: Month/Day/Year or Day/Month/Year

For the Optical Port section, set the Baud Rate to 1200, 2400, 4800, 9600, 19200, 
38400 or 57600. The Optical Receive can be Normal or Inverted.

The User Inactivity Time Outs section refers to the number of minutes since last user 
action when mode reverts to view mode 1. The settings range from 5 to 60 minutes 
with 1 minute intervals and are as follows:

Leave Test Mode After: reverts with or without energy accumulation.;
Leave View Mode 2 After: reverts automatically;
Leave View Mode 3 After: reverts automatically.

Use buttons for functions below:

• Update Display: Click to send the new settings to the display (after 
settings have been updated, view mode 1 is displayed).

• Retrieve From Display: Click to Retrieve existing settings.

• Cancel: Click to cancel any new settings changes.

• Save: Click to save new settings to a file.

• Load: Click to load saved settings from a file.

• Help: Click to get help for this set of screens.
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When finished with the changes, select Update Display to send 
the new settings to the display. 
Pop-up windows will appear to indicate that the changes have 
been made and the software will return to the main GE 
Communicator EXT screen.



4–14 EPM 9800 ADVANCED POWER QUALITY METERING SYSTEM – USER GUIDE

OPERATING INSTRUCTIONS CHAPTER 4: OPERATING INSTRUCTIONS

4.4 Transformer Loss Compensation

4.4.1 Introduction
The Edison Electric Institute's Handbook for Electricity Metering (Ninth Edition) defines loss 
compensation as:

A means for correcting the reading of a meter when the metering point and point of 
service are physically separated, resulting in measurable losses including I2R losses 
in conductors and transformers and iron-core losses. These losses may be added to 
or subtracted from the meter registration.

Loss compensation may be used in any instance where the physical location of the meter 
does not match the electrical location where change of ownership occurs. Most often this 
appears when meters are connected on the low-voltage side of power transformers when 
the actual ownership change occurs on the high-voltage side of the transformer. This 
condition is shown below.

Figure 4-7: Low voltage metering installation requiring loss compensation

It is generally less expensive to install metering equipment on the low-voltage side of a 
transformer and in some conditions other limitations may also impose the requirement of 
low-side metering even though the actual ownership change occurs on the high-voltage 
side.

The need for loss compensated metering may also exist when the ownership changes 
several miles along a transmission line where it is simply impractical to install metering 
equipment. Ownership may change at the midway point of a transmission line where 
there are no substation facilities. In this case, power metering must again be 
compensated. This condition is shown below.

Figure 4-8: Joint ownership line metering requiring loss compensation

M

ownership change

M

Point of
ownership change
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A single meter cannot measure the losses in a transformer or transmission line directly. It 
can, however, include computational corrections to calculate the losses and add or 
subtract those losses to the power flow measured at the meter location. This is the method 
used for loss compensation in the EPM 9800 meter. 

The computational corrections used for transformer and transmission line loss 
compensation are similar. Generically, no-load losses and full-load losses are evaluated 
and a correction factor for each loss level is calculated. However, the calculation of the 
correction factors that must be programmed into the meter differ for the two different 
applications. For this reason, the two methodologies will be treated separately.

In the EPM 9800, loss compensation is a technique that computationally accounts for 
active and reactive power losses. The meter calculations are based on the formulas below. 
These equations describe the amount of active (watts) and reactive (vars) power lost due to 
both iron and copper effects (reflected to the secondary of the instrument transformers). 
The total secondary watt loss Ploss is shown below.

 (EQ 4.1)

The total secondary var loss Qloss is shown below:

 (EQ 4.2)

Where Vm is the measured voltage, Vc is the calculated point voltage, Im is the measured 
current, Ic is the calculated point current, and Sfull is the full-scale secondary VA. The values 
for %LWFE, %LWCU, %LVFE, and %LVCU are derived from the transformer and meter 
information, as demonstrated in following sections.

The calculated loss compensation values are added to or subtracted from the measured 
watts and vars. The selection of adding or subtracting losses is made through the meter 
profile when programming the meter. The meter uses the combination of the add/subtract 
setting and the directional definition of power flow (also in the profile) to determine how to 
handle the losses. Losses will be “added to” or “subtracted from” (depending on whether 
add or subtract is selected) the received power flow. For example, if losses are set to “add 
to” and received power equals 2000 kW and losses are equal to 20 kW then the total 
metered value with loss compensation would be 2020 kW; for these same settings if the 
meter measured 2000 kW of delivered power the total metered value with loss 
compensation would be 1980 kW. 

Since transformer loss compensation is the more common loss compensation method, the 
meter has been designed for this application. Line loss compensation is calculated in the 
meter using the same terms but the percent values are calculated by a different 
methodology as described in a subsequent section below.

In summary, the EPM 9800 transformer loss compensation:

• Performs calculations on each phase of the meter for every measurement taken. 
Unbalanced loads are accurately handled.

• Calculates numerically, eliminating the environmental affects that cause 
inaccuracies in electromechanical compensators.

• Performs bi-directional loss compensation.

• Requires no additional wiring; the compensation occurs internally.

Ploss

Vm

Vc
-------⎝ ⎠
⎛ ⎞

2
%LWFE×⎝ ⎠

⎛ ⎞ Im
Ic
-----⎝ ⎠
⎛ ⎞

2
%LWCU×⎝ ⎠

⎛ ⎞+ Sfull×=

Qloss

Vm

Vc
-------⎝ ⎠
⎛ ⎞

2
%LVFE×⎝ ⎠

⎛ ⎞ Im
Ic
-----⎝ ⎠
⎛ ⎞

2
%LVCU×⎝ ⎠

⎛ ⎞+ Sfull×=
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• Imposes no additional electrical burden when performing loss compensation.

Loss compensation is applied to 1 second per phase watt/var readings and, because of 
this, affects all subsequent readings based on 1 second per phase watt/var readings. This 
method results in loss compensation be applied to the following quantities:

• Total power.

• Demands, per phase and total (thermal, block (fixed) window, rolling (sliding) 
window and predictive window).

• Maximum and minimum demands.

• Energy accumulations.

• KYZ output of energy accumulations.

Note Loss Compensation is disabled when the meter is placed in test mode.

4.4.2 Transformer Loss Compensation in the EPM 9800
The EPM 9800 meter provides compensation for active and reactive power quantities by 
performing the numerical calculations using factors derived by clicking the TLC Calculator 
button on the Transformer Loss screen of the device profile or by manually figuring values 
(refer to Transformer Loss Compensation Worksheet on page 4–17). Enter the derived 
values in the Device Profile screen of the GE Communicator EXT software (values will 
automatically be entered from the TLC calculator button).

The GE Communicator EXT software can enable transformer loss compensation for losses 
due to copper and iron, individually or simultaneously. Losses can either be added to or 
subtracted from measured readings.

Loss compensation values must be calculated based on the meter installation. As a result 
transformer loss values must be normalized to the meter by converting the base voltage 
and current and taking into account the number of elements used in the metering 
installation. For three element meters, the installation must be normalized to the phase-to-
neutral voltage and the phase current; in two element meters the installation must be 
normalized to the phase-to-phase voltage and the phase current. This process is 
described in the following sections.

4.4.3 Loss Compensation in Three Element Installations
Loss compensation is based on the loss and impedance values provided on the 
transformer manufacturer's test report. A typical test report will include at least the 
following information:

• Manufacturer

• Unit serial number

• Transformer MVA rating (self-cooled)

• Test voltage

• No load loss watts

• Load loss watts (or full load loss watts)



CHAPTER 4: OPERATING INSTRUCTIONS OPERATING INSTRUCTIONS

EPM 9800 ADVANCED POWER QUALITY METERING SYSTEM – USER GUIDE 4–17

• Percent of exciting current at 100% voltage

• Percent impedance

The transformer MVA rating is generally the lowest MVA rating (the self-cooled or OA rating) 
of the transformer winding. The test voltage is generally the nominal voltage of the 
secondary or low voltage winding. For three phase transformers these values will typically 
be the three-phase rating and the phase-to-phase voltage. All of the test measurements 
are based on these two numbers. Part of the process of calculating the loss compensation 
percentages is converting the transformer loss values based on the transformer ratings to 
the base used by the meter.

Correct calculation of loss compensation also requires knowledge of the meter installation. 
To calculate the loss compensation settings, the following information is required:

• Number of meter elements

• Potential transformer ratio (PTR)

• Current transformer ratio (CTR)

• Meter base voltage

• Meter base current

This section is limited to application of EPM 9800 meters to three-element metering 
installations. As a result, we know that:

• Number of metering elements = 3

• Meter base voltage = 120 V

• Meter base current = 5 A

The loss compensation values can be calculated by clicking the TLC Calculator button on 
the transformer loss screen of the EPM 9800 device profile. This will open the transformer 
loss calculation spreadsheet (in Excel format).

4.4.4 Transformer Loss Compensation Worksheet
A copy of the transformer loss calculation spreadsheet with example numbers is available 
from the EPM 9800 support documents section of the GE multilin website (http://
www.GEmultilin.com) as GET-8501.xls.

http://www.GEmultilin.com
http://www.GEmultilin.com
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Testing the Meter

5.1 Overview

5.1.1 Warnings

The information contained within this chapter is intended to be an aid to qualified 
metering personnel.  It is not intended to replace the extensive training necessary to 
install or remove meters from service.  Any work on or near energized meters, meter 
sockets or other metering equipment presents the danger of electrical shock, personal 
injury or death.  All work on these products must be performed by qualified industrial 
electricians and metering specialists only!

All work must be done in accordance with local utility safety practices and the 
procedures outlined in the current edition of the Handbook for Electricity Metering.  
The handbook is available from the Edison Electric Institute (http://www.eei.org), 701 
Pennsylvania Avenue N.W., Washington D.C. 20004-2696.

http://www.eei.org
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5.2 Testing Tools

5.2.1 Description
The EPM 9800 is equipped with a light-emitting diode (LED) for calibration and a liquid 
crystal display with test screens. These two standard features provide user interface and 
equipment interface points for meter testing.

5.2.2 Test Pulse LED
The test pulse LED is located in the upper left-hand portion of the meter faceplate. This LED 
continuously emits calibration pulses (infrared light). It can be used for a variety of pulses 
including individual quadrants for watt-hour, VAhour, varhour and watt demand pulses. 
Each calibration pulse is equal to the value assigned to Kt (watthours per pulse) in the 
meter's device profile. The millisecond duration of each output pulse is also programmable 
in the meter's device profile.

To program the test pulse LED, launch the device profile in GE Communicator EXT software 
and click on KYZ Outputs, then click on any of test LED pull-down menus to configure the 
following settings:

• Assigned channel - choose from settings.

• Watt-hour per pulse - enter the value in the secondary.

• Pulse width - can be set from 5 to 635 ms.

• Mode - can be enabled or disabled.

• Form - can be selected between form-A and form-C.

Click OK then click Update Device to send the new settings to the meter.

The unit for the calibration pulses is watt-hours. The initial value of each pulse (Kt) is 1.800 
secondary watt-hours per pulse.

5.2.3 LCD Display
In test mode, the LCD display provides user access to accumulated real, reactive and 
apparent energy as well as block demand for real power. There are eight screens in test 
mode: Wh - Del, Wh - Rec, VARh - Q1 & Q2, VARh - Q3 & Q4, VAh - Q1 & Q4, VAh - Q2 & Q3, 
Watt Demand Test Rolling and Watt Demand Test Block. See Using Test Mode on page 5–
3 for additional detail.

The LCD display also includes three phase voltage annunciators. These annunciators are 
labeled A, B, and C to indicate the presence of voltage on the indicated phase. If voltage is 
not present on one phase, its indicator will not be displayed. These indicators also show 
whether current is flowing on the indicated phase. If no current is flowing on a phase, the 
annunciator will blink. When current is flowing, it will show a continuously illuminated digit. 
This annunciator indicates phase sequence.
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5.3 Test mode

5.3.1 Description
Test mode allows the meter to be tested without disturbing billing data or setting a new 
maximum demand. Test mode performs the same function as setting the pointers back on 
an electromechanical meter after testing.

While operating in test mode, the meter uses the same measurement and calculation 
processes that are used in normal mode. the only difference is that the billing numbers 
stored in the meter are not updated with the real-time reading. This preserves the billing 
numbers while testing is performed.

5.3.2 Entering Test Mode
To enter test mode, the user must pass the meter security system. In most instances, this 
requires the user to remove power from the meter, break the meter seal, remove the Lexan 
cover, and then re-power the meter.

The test button is one of two pushbuttons in the lower right hand side of the meter 
faceplate. 

Press the test button (on the right) to display the Select 
Transformer Loss screen.

Press the test button again to scroll through the following 
transformer loss screens:

• Transformer loss only
• Both CTPT and transformer loss
• No compensation
• CTPT only

Select the desired screen.

Push the test button for 2 to 3 seconds. 
The test mode screens appear and the display changes to indicate 
the user has entered test mode (the word test appears in the upper 
right corner of the screen).

Upon entering test mode, the following processes occur:

1. All energy, demand and TOU values are stored in the EPM 9800 nonvolatile 
memory.

2. Meter log recording is suspended; however, historical logging continues and 
entries to historical logs reflect that test mode is in effect during the effected 
interval(s).

5.3.3 Using Test Mode
The same selected measurement profile quantities (data accumulations) that are 
calculated during normal operation are calculated in test mode. Display quantities (watt-
hours, varhours, VAhours, and block demand quantities) are displayed in units rather than 



5–4 EPM 9800 ADVANCED POWER QUALITY METERING SYSTEM – USER GUIDE

TESTING THE METER CHAPTER 5: TESTING THE METER

kilo-units (i.e. the data is displayed as Wh, varh, VAh and Watts rather than kWh, kvarh, 
kVAh and kW). The same demand values calculated during normal operation are also 
calculated in test mode. The display formats in test mode are changed to provide greater 
resolution during test operations.

The display does not scroll while in test mode. Each item remains displayed until the test 
mode button is pressed. At that time, the next test mode screen is shown.

The following table shows the display screens available in test mode and the data 
displayed on each screen and the pulse source for each screen:

Adjacent to the test mode button (T) is the reset button (R). A test reset is initiated by 
pressing the reset button while in test mode. A test mode reset causes all test quantities to 
be reset to zero and a new block interval to be started. The item displayed when the reset 
occurred remains in the display but the value will be initialized. The reset occurs when the 
reset button is released.

While in test mode, the test pulse LED will pulse at the rate programmed for the meter Kt . 
The value of the meter Kt can be verified from the device profile. The meter quantity 
assigned to the test pulse LED changes as the user moves from one test screen to another. 
The assigned values are defined in the pulse source column of the table above.

Changing the Kt value does not effect EPM 9800 performance or accuracy. The Kt value 
only effects the rate at which the test pulse LED blinks. Smaller Kt values produce more 
pulses for a given load and shorter test time. The tester should ensure that the allowed test 
time is long enough to reduce variability that may be introduced in the starting and 
stopping of the test procedure.

Individual quadrant tests for varhours can be completed by proper test design. To test 
strictly varhours, limit the test parameters to one quadrant during testing.

In the event of a power outage, data for test mode energy, demand and power factor are 
not saved. Upon power-up, the meter returns to normal mode. The test data is lost and all 
registers are restored to their pretest values.

While in test mode, the infrared port and communications port 1 are available for 
communication with the meter.

In test mode, the user can preset the values of the energy readings that will be restored to 
the meter when test mode is exited. This is accomplished via the GE Communicator EXT 
software (see Test Mode Preset Accumulators on page 5–5).

Table 5–1: Test mode displayed data and pulse source

Test mode Displayed data Pulse source

Wh - del Delivered energy in Wh kWh, Del

Wh - rec Received energy in Wh kWh, Rec

VARh - Q1 & Q2 Reactive energy (varh) in quadrants 1 and 2 kvarh, Del

VARh -Q3 & Q4 Reactive energy (varh) in quadrants 3 and 4 kvarh, Rec

VAh - Q1 & Q4 Apparent energy (VAh) in quadrants 1 and 4 kVAh, Q1

VAh - Q2 & Q3 Apparent energy (VAh) in quadrants 2 and 3 kVAh, Q3

Watt Demand Rolling Power block demand delivered (watts) kWh, Del

Watt Demand Block Power block demand delivered (watts) kWh, Del
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5.3.4 Test Mode Exit Delay Setting
Use the following procedure to set the exit delay time.

From the device profile screen, click the Test Mode icon or double-
click on the Test Mode Settings line. 
The Test Mode Settings window appears:

Note The Test Mode icon and screen appear only if the display firmware is less than 40. If the 
display firmware is greater than 40, this setting will appear in the programmable settings.

Use the pull-down menu to select the delay time in minutes (from 1 
to 255 minutes). 
This is the time in which GE Communicator EXT will exit test mode if 
there is no activity. 

Click OK to return to the main device profile screen.

For the changes to take effect, click on the Update Device button. 
This sends the new profile to the EPM 9800.

5.3.5 Test Mode Preset Accumulators
There are two reasons why a user might want to use the preset accumulators screens:

1. A monitor in test mode is out of service and is therefore not monitoring 
accumulations. The new value can be used to adjust for the values not 
monitored while in test mode.

2. When replacing an old meter that has accumulations with a new meter that 
has no accumulations, the new value can be set with the value of the 
accumulations of the old meter.
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To set the test mode preset accumulators:

Select the Tools > Test Mode > Preset Accumulators menu item.
 The set of screens shown here (Test Mode Preset) appears.

Each screen has a current value, new value and preset box for each accumulator. A new 
meter will have zeros for current values.

Click the tabs at the top of the window to access the individual 
screens. 
Settings can be preset for the following sets of values: primary 
energy, secondary energy, primary energy (quadrants), secondary 
energy (quadrants), internal input accumulators, KYZ output 
accumulators, Q hours, current and voltage squared T 
accumulators, cumulative demand (secondary), and 
uncompensated energy.

Select the Preset boxes for values to set.

Click Set or Cancel.

5.3.6 Exiting Test Mode
Test mode is exited in one of three ways:

1. By pressing and holding the test button for more than 3 seconds.

2. By the test mode time-out timer, if no load is present.

3. By the extended test mode time-out timer, if load is present.

Pressing the test mode button for more than three seconds will immediately exit test 
mode.
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The test mode time-out timer has two modes of operation, depending on whether the 
meter sees measurable load.

• If the meter does not recognize measureable load: The meter watches for user 
interaction by monitoring activity on the test button and the reset button.  If neither 
button is pushed within the programmed exit delay time, the meter will automatically 
exit test mode and return to normal mode.  Each time the test or reset button is 
pressed, the meter starts the exit delay timer again.  The exit delay time is 
programmed in the EPM 9800 device profile.

• If the meter recognizes measurable load: It watches the test and reset buttons for 
activity but uses a different time limit.  When load is present, it uses an extended time 
consisting of the exit delay time plus the programmed block interval time.  This insures 
that the meter can complete a full block demand test without interruption.

All test mode data is lost when test mode is exited. Upon exiting test mode, a new (possibly 
partial) demand interval and subinterval are started. The past subinterval as well as the 
current subinterval are zeroed. Upon returning to normal operating mode, a time-of-use 
meter or demand meter with load profiling will complete the time remaining in the current 
partial subinterval such that subsequent subintervals will be synchronized with the hourly 
boundary.

Maximum demand values for each demand integration type are not modified while in test 
mode. The previously recorded maximums will be restored when test mode is exited. If the 
user desires to reset demand data during testing operations, this action can be completed 
after test mode is exited by pressing the Reset Button after the meter has reset to normal 
mode.

Note Normal billing and historical log data accumulation is suspended during test mode 
operation. Upon exiting test mode, accumulation of billing and historical log quantities will:

1. Resume from the values in place when test mode was entered, or

2. Continue from the values preset while in test mode.
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6.1 Communications Wiring

6.1.1 Overview
RS232 communication is used to connect a single EPM 9800 with another device, such as a 
computer, RTU, or PLC. The link is viable for up to 50 feet (15.2 meters) and is available only 
through the EPM 9800 optical port with a communication interface (optical port to RS232 
converter).

RS485 communication allows multiple meters to communicate with another device at a 
local or remote site. The input/output modules use RS485 to communicate with the meter. 
All RS485 links are viable for up to 4000 feet (1220 meters). The EPM 9800 ports 1 and 4 are 
two-wire, RS485 connections (up to 115200 bps). Optional communication interfaces for 
internal modem with dial in/dial out, 10/100Base-T Ethernet, combination modem and 
Ethernet are available.

Figure 6-1: Communications overview

RS232

RS232Optical port to RS232
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Modem

RS232
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6.1.2 ANSI Type II Optical Port
Use the ANSI type II optical port on the face of the EPM 9800 for RS232 communications. 
The optical port is compatible with the A7Z communication interface and other ANSI type II 
magnetic communication interfaces.

Figure 6-2: A7Z communications interface

One end of the magnetic interface simply snaps onto the optical port and is kept in place 
by the magnet; the other end is an RS232 connection. Insert the RS232 end into a 9-pin 
serial port on a computer or other device. The A7Z requires no power supply – all power is 
received from the host computer serial port using transmitter and receiver circuits within 
the probe.

The RS232 standard limits the cable length to 50 feet (15.2m).

6.1.3 RS485 Serial Communication
RS485 communications allow multiple devices to communicate on a bus. Ports 1 and 4 of 
the EPM 9800 are RS485 terminals, viable for a distance of up to 4000 feet (1219 meters). A 
detail of a two-wire RS485 port is shown below.

Figure 6-3: Two-wire RS485 port (detail)

Connect (–) to (–) of
the next device

Connect (+) to (+) of
the next device

Twisted-pair, shielded cable

EPM 9800
2-wire RS485 port

S + –
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The RS485 shield is not an earth-ground connection – the shield must be connected to 
earth-ground at one point. Do not connect the shield to ground at multiple points as it 
interferes with communication. For the A+ and B– two-wire RS485 communication 
terminals, connect the A+ terminal of the meter to the positive (+) terminal of the device. 
Likewise, connect the B– terminal of the meter to the negative (–) terminal of the device.

For all RS485 connections:

• Use a shielded twisted pair cable 22 AWG (0.33 mm2) or larger, grounding the 
shield at one end only.

• Establish point-to-point configurations for each device on an RS485 bus. Connect 
positive (+) terminals to positive (+) terminals, and connect negative (–) terminals to 
negative (–) terminals.

• Protect cables from sources of electrical noise.

• Avoid both “star” and “tee” connections (see Figure 6-5: Incorrect “T” and “star” 
topologies on page 6–4). No more than two cables should be connected at any one 
point on an RS485 network, whether the connections are for devices, converters, 
or terminal strips.

• Include all segments when calculating the total cable length of a network. If there 
is no RS485 repeater, the maximum length for cable connecting all devices is 4000 
feet (1219 meters).

A typical two-wire RS485 connection is shown below.

Figure 6-4: Typical two-wire RS485 connection

Termination resistors (RT) are generally used on both ends of longer length transmission 
lines. The value of the termination resistors is determined by the electrical parameters of 
the cable.

RT ≈ Ω120
(for runs typically longer than 500 ft.)

RT ≈ Ω120
(for runs typically longer than 500 ft.)

S + –

S B(–) A(+)
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Note The EPM 9800 meter may be shipped with connectors on the ends of cables or they may 
be shipped as pigtails (no connectors). In this case, a generic terminal block will be shipped 
with the meter. The terminal block has up to 12 connectors and can be cut into smaller 
sections with a utility knife. Please refer to the Table 3–1: Cable color key on page 3–4 if 
using pigtails or for information about connector identities.

Note Termination resistors are only needed with runs typically more than 500 feet. The meter 
has some level of termination internally and usually resistors are not needed.

“Star” and “tee” connections must be avoided. These are illustrated in the following figure.

Figure 6-5: Incorrect “T” and “star” topologies

"Tee" connection incorrect

The three wires connected
in a "T" shape on both the
(–) and (+) terminals will
cause interference problems

"Star" connection incorrect
The three wires connected
in a "star" shape on both the
(+) and (–) terminals will
cause interference problems

INCORRECT "T" CONNECTION

INCORRECT "STAR" CONNECTION

A(+)

B(–)

S

(+)(–) S

S B(–) A(+) S B(–) A(+) S B(–) A(+)RS485 ports
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6.2 RS485 Serial Connections

6.2.1 Connection to an RS485 Master
Use port 1 or port 4 to connect to an RS485 master. For information on connecting the EPM 
9800 to a modem, see Programming Modems for Remote Communications on page 6–11. 
The RS485 link is viable for up to 4000 feet (1219 meters). An RS485 to RS232 converter 
may be required (such as the GE Multilin F485 or similar devices).

To establish communication between a meter and any RS485 master, use a shielded, 
twisted pair cable.

Connect the cable to an RS485 port (port 1 or port 4) on the EPM 9800. Connect the A(+) 
and B(-) terminals on the EPM 9800 to the positive (+) and negative (–) terminals on the 
master, respectively. Provide jumpers only on a four-wire master, linking its two negative 
terminals and two positive terminals. An RS485 communication is reliable up to 4000 feet 
(1219 meters).

Connect the shield to the ground (G) terminal on the master. The shield must also be 
connected to earth-ground at one point. Provide resistors at each end, connected to the 
positive (+) and negative (–) lines. The termination resistance RT is approximately 120 ohms.
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Note Termination resistors are only needed with runs typically greater than 500 feet. The EPM 
9800 has some level of internal termination and resistors are not generally not required for 
lengths less than 500 feet.

Figure 6-6: EPM 9800 connected to an RS485 master

6.2.2 Connection to Input/Output Modules via RS485
Input/output modules can also be connected to the EPM 9800 with an RS485 cable 
harness (supplied with the purchase of the MBIO mounting brackets). Insert one end of the 
cable into port 4 of the meter and the other end of the cable into the communication pins 
of the input/output module male RS-485 side port (see EPM 9800 connected to an RS485 
master on page 6–6).

The EPM 9800 power supply will not supply power to any external input/output modules. 
An external 12 V power source (such as the PSIO) must be used. RS485 communication is 
reliable for up to 4000 feet (1219 meters).

The following figure illustrates the input/output modules connection via RS485.

RT = 120 ohms
(for runs typically longer than 500 ft.)

RT = 120 ohms
(for runs
typically longer
than 500 ft.)

Port on RS485
master

RS485 port on
EPM 9800 meter

S A(+) B(–)

–– + + G
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Figure 6-7: EPM 9800 connected to input/output module via RS485

Connect the A(+) and B(–) terminals on the EPM 9800 to the A(+) and B(–) terminals of the 
female RS485 port. Connect the shield to the shield (S) terminal. The (S) terminal is used to 
reference the meter port to the same potential as the source. It is not an earth ground 
connection – the shield must be connected to earth-ground at one point.

Provide termination resistors at each end (see note below), connected to the A(+) and B(–) 
lines. The resistance of RT is approximately 120 ohms.

Note Termination resistors are only needed with runs typically more than 500 feet. The EPM 
9800 has some level of internal termination and resistors are not generally not required for 
lengths less than 500 feet.

6.2.3 Linking Multiple Devices
A total of 31 meters may be connected in series on a single bus using RS485. The cable 
length may not exceed 4000 feet (1219 meters). Before assembling the bus, each meter 
must be assigned a unique address.

RT = 120 ohms
(for runs typically longer than 500 ft.)

RT = 120 ohms
(for runs typically longer than 500 ft.)

Male side port
on input/output module

EPM 9800 port 4

External power
source

(PSIO or equivalent)

S A(+) B(–)

A(+) B(–) S V– V+

+
–
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Connect the A(+) and B(–) terminals of each device. Break the shield between the RS485 
master and between device segments as shown below. It is not an earth ground 
connection. The shield must be connected to earth-ground at one point. Connect resistors 
at each end to the (+) and (–) lines. The resistance of RT is approximately 120 ohms.

Figure 6-8: Linking multiple meters

6.2.4 Remote Communications over Telephone Lines
The use of modems (dedicated or dial-up) is recommended when devices are at great 
distances. For units without the built-in modem option, RS485 wiring with a GE Multilin 
F485 converter is recommended.

Figure 6-9: RS485 remote connections

Use port 1 or port 4 for RS485 communication. The RS485 link is reliable up to 4000 feet 
(1219 meters). Set an appropriate baud rate and enable the Modbus ASCII protocol.

An RS485 to RS232 converter is also required. GE recommends the GE Multilin F485 
converter. See Programming Modems for Remote Communications on page 6–11 for 
additional details.

S A(+)B(–) S A(+)B(–)S A(+)B(–) S A(+)B(–)

RT
RT

Remote PC Originate
modem

Telephone
line Remote

modem

Null-modem adapter GE Multilin F485 converter
(or equivalent)

RS485 line

EPM 9800
meter
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6.3 RJ11 Modem Connections

6.3.1 Description
The internal modem option for the EPM 9800 provides a direct connection to a standard 
telephone line. No additional hardware is required to establish a communication 
connection between the meter and a remote computer.

The modem operates at speeds up to 56 kbps. The internal connection between the 
modem and the meter includes a memory buffer. This enables the modem to connect to 
the phone line at any speed and to change speed during the communication connection 
to the remote PC. The buffer between the meter and the modem allows the meter to 
communicate into the modem at a constant speed while the modem telephone line speed 
can vary. This eliminates the synchronizing problems that are common with other devices. 
It also increases the effective throughput of the communication channel. This, in turn, 
decreases connection time and connection costs.

The modem supports both incoming calls (from a remote computer) and automatic dial-
out calls when a defined event must be automatically reported.

6.3.2 Hardware Connection
Units with an internal modem contain two RJ11 jacks that pigtail from the back of the 
meter: one is a line connection for the outside line; the other is a connection for a phone. A 
standard telephone RJ11 plug can connect the meter to a standard PSTN (public switched 
telephone network). The phone jack is the override of the modem function when the phone 
is in use.

When the EPM 9800 is ordered with the internal modem option, it contains dial-in 
capability and provides remote access to other Modbus-based serial devices via the EPM 
9800 RS485 gateway over a phone line. The EPM 9800 will recognize and respond to a 
Modbus address of 1. With any other address, the command will pass through the 
gateway and become a virtual connection between the remote Modbus master and any 
Modbus slave connected to the RS485 gateway.

6.3.3 Dial-in Function
The modem continuously monitors the telephone line to detect an incoming call. When an 
incoming call is detected, the modem will wait for user-defined number of rings and 
answer the call.

The modem can be programmed to check for a password on an incoming call. In this case, 
the modem will hang up on the incoming call if the correct password is not provided. If 
several unsuccessful incoming call attempts are received in a set time period, the modem 
will lock-out future incoming calls for a user-defined number of hours.

When an incoming call is successfully connected, the control of communications is passed 
to the calling software. The modem will respond to computer commands to download 
data or other actions authorized by the meter passwords. Refer to Programming Modems 
for Remote Communications on page 6–11 for programming details.
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6.3.4 Dial-out Function
The dial-out function allows the EPM 9800 to automatically report certain conditions 
without user intervention. The modem normally polls the meter to determine if any 
abnormal or reportable conditions exist. The modem checks the following meter 
conditions and programmed events to determine if a call should be placed.

• Are any meter setpoint limits exceeded?

• Has the status of the high-speed inputs changed?

• Has a waveform been recorded?

• Has a power quality event been recorded?

• Has a control output changed?

• Has the meter experienced a loss of control power?

• Is either the history log approaching a full condition?

• Is the event log approaching a full condition?

• Is any other log approaching a full condition?

• Has the modem password failed?

• Has communication with the meter failed?

If any of the monitored events exist, the internal modem will automatically initiate a call to 
a specified location to make a report or perform some other function. For log full 
conditions, the EPM 9800 will automatically download the log(s) that are nearing the full 
state. The modem can be programmed to call two different numbers to make the required 
reports, primary and backup.

The internal modem can be programmed with an ASCII string for identification purposes. If 
this string in present the modem will play the string to the host computer upon connection 
to identify the meter to the host software.

The internal modem includes a connection for an external 3 V Lithium battery (with custom 
leads and velcro mounting) to power the modem if the meter loses control power. Using 
the battery, the modem will be able to complete a reporting call even if power to the meter 
has been disconnected. This feature allows the meter to report power outage conditions. 
Under normal conditions, the battery should provide in excess of 10 years of service during 
storage conditions (disconnected from terminals) or when properly installed in an 
energized meter. The battery should provide more than one year of service during outage 
conditions (on battery backup). A low battery indicator will appear on the display screen 
when there is a low battery.

Replacement of the battery is simple. The battery is attached to a cable (if ordered) which 
pigtails from the back of the meter with a connector (see below and Battery Installation 
and Maintenance on page 3–6).

Installation steps:

Remove the old battery by disconnecting it at the connector.

Install the new battery by snapping it into the connector.

Peel and stick the velcro adhesive somewhere outside the meter (or 
use the old adhesive to fasten the battery in place).
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Note Custom leads and velcro mounting are not included in some earlier versions of the 
switchboard meter. Contact GE Multilin for details.

6.3.5 Programming Modems for Remote Communications
When a modem speaks to most RS485 or RS232-based devices, it must be programmed to 
certain settings for the communication to work. This task is often quite complicated. The 
steps below illustrate how to communicate with the remote meter(s).

For the modem connected to a remote PC (the originate modem):

Restore the modem to factory settings to erase all previously 
programmed settings.

Set the modem to display result codes. 
These will be used by the remote PC.

Set the modem to verbal result codes. 
These will be used by the remote PC.

Set the modem to use the DTR signal. 
This is necessary for the remote PC to ensure proper connection 
with the originate modem.

Set the modem to enable flow control. 
This is necessary to communicate with remote modem connected 
to the EPM 9800.

Set the modem to write the new settings to activate the profile. 
This places the settings into nonvolatile memory; they will take 
effect after the modem powers up.

For the modem connected to the EPM 9800 (the remote modem):

Restore the modem to factory settings to erase all previously 
programmed settings.

Set the modem to auto answer on N rings.

Set modem to ignore the DTR signal. 
This is necessary to ensure connection with originate modem.

Set modem to disable flow control; RS232 communication does not 
support this feature.

Set the modem to write the new settings to activate the profile. 
This places the settings into nonvolatile memory; they will take 
effect after the modem powers up.

When programming the remote modem with a terminal program, 
ensure the baud rate of the terminal program matches the meter 
baud rate.
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Selected modem strings/settings are shown below.
Table 6–1: Modem strings/settings

Modem String/setting

Cardinal modem AT&FE0F8&K0N0S37=9

Zoom/Faxmodem VFX V.32BIS(14.4K) AT&F0&K0S0=1&W0&Y0

Zoom/Faxmodem 56Kx Dual Mode AT&F0&K0&C0S0=1&W0&Y0

US Robotics Sportster 33.6 Faxmodem AT&F0&N6&W0Y0 (for 9600 baud)
DIP switch setting: up-up-down-down-up-up-up-down

US Robotics Sportster 56K Faxmodem AT&F0&W0Y0
DIP switch setting: up-up-down-down-up-up-up-down



CHAPTER 6: COMMUNICATIONS COMMUNICATIONS

EPM 9800 ADVANCED POWER QUALITY METERING SYSTEM – USER GUIDE 6–13

6.4 RJ45 Ethernet Connections

6.4.1 Overview
The Ethernet RJ45 option conforms to the IEEE 802.3, 10/100Base-T specification using 
unshielded twisted pair (UTP) wiring. This allows the use of inexpensive RJ45 connectors 
and CAT 3 or better cabling. The RJ45 connector is supplied with the meter (cable 6).

Using this LAN connection allows multiple PCs to concurrently access the EPM 9800. The 
RJ45 line is inserted into the RJ45 connector on cable 6 from the back of the EPM 9800. The 
RJ45 connection into the meter connects the EPM 9800 to a network via the Modbus/TCP 
protocol.

The 10/100Base-T Ethernet option includes a fully customizable web server that uses XML 
to provide access to real-time data via Internet Explorer. The system incorporates a highly 
programmable network card with built-in memory. Each card can be programmed to 
perform an extensive array of monitoring functions.

6.4.2 Hardware Connection
The EPM 9800 with the 10/100Base-T Ethernet option has all the components of the 
standard EPM 9800 plus the capability of connection to a network through an Ethernet 
LAN or through the Internet via Modbus TCP, HTTP, SMTP, FTP and/or DHCP.

The internal network option is an extremely versatile communication tool with the 
following features:

• Adheres to IEEE 802.3 Ethernet standard using TCP/IP.

• Utilizes simple and inexpensive 10/100Base-T wiring and connections.

• Connects to networks using standard built-in RJ45 jack.

• Programmable to any IP address, subnet mask, and gateway requirements.

• Communicates using the industry standard Modbus/TCP protocol.
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6.5 Simultaneous Modem/Ethernet Connections

6.5.1 Overview
The combination modem/Ethernet option is an extension of the regular Ethernet option. It 
has all the features of the Ethernet option with a built-in modem. The modem and Ethernet 
capabilities can be used simultaneously.

The protocol supported by the modem is Modbus ASCII. The protocol supported by the 
RS485 ethernet/modem gateway is Modbus RTU. The combination modem/Ethernet 
option converts all incoming modem Modbus ASCII requests to Modbus RTU for internal 
and gateway communication. It then converts all response Modbus RTU messages into 
Modbus ASCII protocol before it sends the responses to the modem.

The fixed parameters for the Ethernet/modem gateway are: 8 data bits, even parity, and 1 
stop bit. The Ethernet/modem gateway baud rate and delay time are configurable.
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6.6 DNP Communications

6.6.1 Features
The EPM 9800 Advanced Power Quality Metering System supports DNP V3.00 level 2. The 
following features are supported:

• Up to 136 measurements (64 binary inputs, 8 binary counters, 64 analog inputs) 
can be mapped to DNP static points (over 3000) in the customizable DNP point 
map.

• Up to 16 relays and 8 resets can be controlled through DNP level 2.

• Report-by-exception processing (DNP events) deadbands can be set on a per-point 
basis.

• 250 events of combination of four events (binary input change, frozen counter, 
counter change, analog change).

• Freeze commands: Freeze, Freeze/No-Ack, Freeze4 with Time, Freeze with Time/
No-Ack.

• Freeze with time commands enable the EPM 9800 meter to have internal time-
driven frozen and frozen event data. The data is created when the meter receives 
the time and interval.
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EPM 9800 Advanced Power Quality 
Metering System

Chapter 7: Miscellaneous

GE Consumer & Industrial
Multilin

Miscellaneous

7.1 Revision History

7.1.1 Release Dates

7.1.2 Changes to the Manual

Table 7–1: Release dates

Publication GE part number EPM 9800 revision Release date

GEK-113198 1601-224-A1 1.0x 20 January 2005

GEK-11319C 1601-224-A2 1.0x 1 May 2007

Table 7–2: Revision A1 to A2

Section Description
Ch. 8 Add Chapter 8 - GE Communicator Software

General Manual revised to A2

General New formatting including new cover graphics

Cover Remove reference to UL #A3775
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7.2 Warranty

7.2.1 GE Multilin Warranty
General Electric Multilin (GE Multilin) warrants each device it manufactures to be free from 
defects in material and workmanship under normal use and service for a period of 24 
months from date of shipment from factory.

In the event of a failure covered by warranty, GE Multilin will undertake to repair or replace 
the device providing the warrantor determined that it is defective and it is returned with all 
transportation charges prepaid to an authorized service centre or the factory. Repairs or 
replacement under warranty will be made without charge.

Warranty shall not apply to any device which has been subject to misuse, negligence, 
accident, incorrect installation or use not in accordance with instructions nor any unit that 
has been altered outside a GE Multilin authorized factory outlet.

GE Multilin is not liable for special, indirect or consequential damages or for loss of profit or 
for expenses sustained as a result of a device malfunction, incorrect application or 
adjustment.

For complete text of Warranty (including limitations and disclaimers), refer to GE Multilin 
Standard Conditions of Sale.
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EPM 9800 Advanced Power Quality 
Metering System

Chapter 8: GE Communicator EXT

GE Consumer & Industrial
Multilin

Configuring the EPM 9800 Meter

8.1 Overview

EPM 9800 Advanced Power Quality Metering System enables you to configure an EPM 
9800 Socket Meter’s programmable settings, which are stored in the unit’s Device Profile. 
The Device Profile has four sections (below) plus I/O Modules.

Following is an overview of the procedure for configuring an EPM 9800 Meter:



8–2 EPM 9800 ADVANCED POWER QUALITY METERING SYSTEM – USER GUIDE

OVERVIEW CHAPTER 8: GE COMMUNICATOR EXT

1. Retrieve the meter’s Device Profile (section 8.2)

2. Configure the programmable settings stored in the Device Profile (sections 
8.3–8.7)

3. Send the new Device Profile back to the Meter (section 8.2).

Note If you click the Save, Load or Update buttons, you MUST have a unique meter Destination 
Label so that the file is saved, loaded or updated to the intended device.

Note This chapter also covers:

• Resetting Meter Information (section 8.9)

• Setting and Retrieving Meter Time (section 8.10)

• Test Mode Preset Accumulators (section 8.14) and Options (section 8.15)

Note Actual programming screens may vary depending on the options ordered with your meter.

Note The settings shown are for the EPM 9800, which supports DNP Level 2. For a Feature 
Comparison of GE models, refer to section 1.6 of the GE Communicator EXT Guide. For 
details on DNP Level 2, see Chapter 17 of the GE Communicator EXT Guide. The External 
Devices section of the Device Profile is covered in Chapter 11 of this same guide.
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8.2 Retrieve and Send Device Profiles

Click on the Profile button, or select Tools > Edit Current Device 
Profile. EPM 9800 Advanced Power Quality Metering System 
retrieves the programmable settings from the currently connected 
meter. 
The following screen appears:

When the settings have been retrieved successfully, the Device Profile screen appears. This 
screen contains all the programmable settings currently stored in the connected meter. 

Configure each of the programmable settings by clicking on the 
+/- icon and then double-clicking on the selected parameter. 
(See sections 8.3–8.25 for details on editing each setting.)

After you have finished configuring any or all of the programmable settings, use the 
BUTTONS at the bottom of the screen as follows:
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Click on the settings you would like to save, then proceed with the 
Update.

Implement the changes by clicking on the Update Device button. 
This sends the new, edited Device Profile to the meter. 

Note You must update the Meter Device profile for any of the programmable settings to take 
effect.

A Warning will appear asking you if you want to Save Connected Device Settings. 

Store the profile for later use by clicking on the Save button. 
A dialogue box will ask where you would like to save the profile.

Open a previously saved profile by clicking on the Load button. 
A dialogue box will ask for the location of the saved profile.

Print a copy of the profile by clicking on the Report button. 
The Report screen will appear as shown here:

Using the Report Page:

Page Arrows: Select a page to view.

Zoom: Adjusts the Viewing Magnification.
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Print Range: Adjusts the Range of Pages to be printed at 100%.

Buttons:

Copies: How many copies do you want to print?

Print Pages: Select individual pages to print. Separate Page Numbers by Commas.

Print: This button sends you to Print Setup screen where you select printer, 
properties, paper and page orientation. Click OK to Print.

Save: Save these selections for future use.

Done: Exit the screen and return to the Device Profile screen.

Note If you change the Com settings for the meter, you will not be able to communicate with the 
meter. You will have to sign off and sign on again with the new settings.
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8.3 General Settings

“General Settings” is the first group of settings in the Device Profile.

From the Device Profile screen (see section 8.2), click on the (+/-) 
button or double-click on the “General Settings” line. 
All of the settings in the General Settings Group are listed.

Click on the particular Programmable Setting you would like to 
configure. 
The settings will be detailed in the order they appear on the Device 
Profile screen.

8.3.1 CT and PT Ratios and System Hookup
From the Device Profile screen (see section 8.2), click on General 
Settings

Double-click on the CT, PT Ratios and System Hookup line. 
The following submenu appears:
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This screen displays the current Device Profile’s settings for CT, PT ratios and the meter 
form used for hookup. The values shown are for example only.

Double-click on any of the settings.
The CT and PT Ratios screen appears:

Make changes to this screen according to the requirements of your application. 

• When you change a PT or CT ratio, EPM 9800 Advanced Power Quality Metering 
System updates the corresponding Full Scale value entered in the Limits and 
Waveforms Full Scale setting.

• Using the pull-down menu, choose the hook up service that matches the 
connection you have to the EPM 9800. Selections may include: 9S 4-Wire Wye or 
Delta, 36S 4-Wire Wye, 39S 4-Wire Wye and 45S 3-Wire Delta or 4-Wire Wye. The 
Device Profile screen, including the Form above the connection window, will reflect 
your selection. 
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Note Changes to the Operational Frequency Range do not change the Full Scale Value for 
Frequency. Changes must be made in the “Limits and Waveform Full Scale Settings” 
screen. Like Voltage and Current, the nominal value should be used. For example, 50 for 
50Hz circuits.

Click OK. 
The following screen asks you to verify the Kh/Ke Ratio for the Test 
Pulse Setting. Kh/Ke Ratio is Secondary Watthour Constant over 
kWh (the energy).

Click Yes, or Click No, and re-enter values in the CT & PT Ratio 
screen.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

Click on the Update Device button. 
This sends the new profile to the Meter. 

Reset Logs, clearing logs and accumulations.

Be sure to capture needed meter information before updating the device. Data will no 
longer be available after the Reset. The meter will be prepared for new installation.

8.3.2 One Amp Current Input Addendum (Modification Number M10.0)
For special circumstances, the Meter can be ordered with one amp current transformers. 
This will give the Meter a range of 0 to 1 amps with an additional over-range of 1 amp.

This option is used where 1A IEC meters are required or extended low current performance 
is needed and higher current performance is not needed. This option is not used for most 
1A installations. The standard Meter has the capability of very accurately monitoring 1A 
loads and providing extended current overload.
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The following shows the change made to the toroid to adjust for the modification.

In order to maintain maximum accuracy with one (1) amp current inputs, the wire is wound 
around the internal toroids five (5) times, instead of the usual one time. This effectively 
multiplies the current input by five (5) times, to maintain maximum resolution.

No modification is required to the CT Ratios because EPM 9800 CT 
Ratios automatically adjust internally for this modification.

Note Use of the M10.0 Option is not recommended unless direct 1A IEC meter replacement of 
very extended low current performance is needed.

8.3.3 Limit and Waveform Full Scales
All Limit and Waveform settings (sections 8.5.1 and 8.5.3, respectively) are based on a 
percentage of the Full Scale. Full Scales are based on the CT and PT ratios (see section 
8.3.1).

Be sure to set the CT and PT ratios first
EPM 9800 Advanced Power Quality Metering System automatically 
recalculates the Full Scales every time the CT and PT ratios change 
and should be verified every time CT and PT Ratios are changed.

Standard 5 amp 
input (one wind 

Modified 1-amp 
input (5 winds 
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Note Changing the CT and PT Ratios will reset the meter, clearing logs and stored data. This 
action prepares the meter for placement in a new installation or changing of the 
Instrument Transformers.

From the Device Profile screen (see section 8.2), click on the +/- 
button beside General Settings

Click on the Limit and Waveform Full Scales line. 
The following submenu appears:

The EPM 9800 screen displays the Device Profile’s settings for the 
Limit and Waveform Full Scales.

Note Frequency and Voltage values are nominal values. The Phase Powers are computed using 
nominal voltage and rated maximum current.

Double-click on any of the settings.
The Limit and Waveform Full Scales screen appears.

Enter the Full Scale for each parameter:
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• The Limit and Waveform settings (section 8.5.1 and 8.5.3, 
respectively) will be based on a percentage of the Full Scales 
entered here.

• EPM 9800 Advanced Power Quality Metering System 
automatically recalculates the Full Scales Voltages, Currents and 
Power every time the CT and PT Ratios change. Frequency is not 
changed, even if the Range

• Selection is changed. Frequency must be changed on the Limits 
screen. ï Power Phase is the amount of power per each phase.

• Power Total is the power of all phases combined.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you must click on the Update 
Device button. 
This sends the new profile to the meter. 

To Reset Logs, see section 8.26

8.3.4 Time Settings

To edit a Device Profile’s time settings:

From the Device Profile screen (see section 8.2), click on the +/- 
button or double-click on the Time Settings line. 
The following submenu appears: 

This screen displays the current Device Profile’s time settings.  
(DST=Daylight Savings Time.)
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Double-click on a programmable setting (eg: Time Zone). 
The Time Settings screen appears.

Make changes to this screen according to the requirements of your 
application:

• Zone Descriptor: 
Sets the Time Zone for the Meter. (0=Greenwich Mean Time).

Table 8–1: Greenwich Mean Time (GMT) Table (Dublin, London)

-1:00 Azores +1:00 Brussels, Paris, Warsaw

-2:00 Mid-Atlantic +2:00 Athens, Cairo, Helsinki

-3:00 Buenos Aires, Georgetown +3:00 Baghdad, Kuwait, Moscow, 
Teheran

-4:00 Atlantic Time (Canada), 
Santiago

+4:00 Kabul, Baku

-5:00 Eastern Time (US & Canada), 
Lima

+5:00 Karachi

-6:00 Central Time (US & Can), Mx 
City

+6:00 Daka

-7:00 Mountain Time (US & Canada) +7:00 Bankok, Hanoi, Jakarta

-8:00 Pacific Time (US & Can), 
Tijuana

+8:00 Beijing, Hong Kong, Singapore

-9:00 Alaska +9:00 Osaka, Sapporo, Seoul
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• Daylight Savings Information:

Enable: Enables an automatic adjustment for daylight savings.

Disable: Disables an automatic adjustment for daylight savings.

Auto DST: Sets Daylight Savings Time automatically for the 
United States only. Time changes automatically occur at 2:00 
AM (your local time), on the first Sunday in April and the last 
Sunday in October.

User Defined: Allows you to set the Daylight Savings Time 
manually.

Start: Set the Month, Day and Hour when the adjustment for 
Daylight Savings will commence.

End: Set the month, day and hour when the adjustment for 
Daylight Savings will conclude.

• Line Synchronization: Set Enable or Disable and Frequency.

The basic function of Line Synchronization is to adjust the real 
time clock to track the time based on the power line frequency. 
For this purpose, Phase A voltage ONLY is used. Line Sync is 
disabled if a GPS signal is present.

• How Time is Adjusted: 

After the clock is synchronized to the line, the meter periodically 
checks the cumulative difference between the real time clock in 
cycles and the line cycle count. If the absolute difference is 
greater that 50 (60) cycles, the clock is adjusted ±1 second 
accordingly.

To set the meter on-board clock, use Set Meter Time from the 
Tools menu. (see section 8.26).

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you must click on the Update 
Device button. 
This sends the new profile to the Meter. 

To Reset Logs, see later sections.

-10:00 Hawaii +10:00 Brisbane, Melbourne, Guam, 
Hobart

-11:00 Midway Island +11:00 Magadan, Solomon Islands

-12:00 Eniwetok +12:00 Auckland, Fiji

Table 8–1: Greenwich Mean Time (GMT) Table (Dublin, London)
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8.3.5 Labels

Labels are user-defined names for the Meter, the Auxiliary Voltage 
terminal and the I N Measured terminal.

Note It is important to label the meter (under Meter Designation because the label given will 
become the name of the file for any logs retrieved from that meter; see Chapter 8 of the GE 
Communicator EXT Guide for details on viewing stored logs.

From the Device Profile screen (section xxx), click on the +/- button 
beside General Settings, then click on Labels. 
The following submenu appears:

Double-click on any of the designation names.
The following screen appears.

Enter the labels in the appropriate fields. 
Meter Designation MUST be set for Partial Log Retrieval.

When all changes are entered, 

Click OK to return to the main Device Profile screen. 

Click on the Update Device button to effect changes. 
This sends the new profile to the meter.
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Note For meter designations, you can use any character allowed by Windows Operating System 
for a File Name (since that meter designation will be used as the File Name).
In English versions the following characters will not work:
                                             \ / : * ? “ < > |.
For meters used internationally by multilingual users, it is recommended that you use ONLY 
alphanumeric characters allowed by your Operating System.

8.3.6 Communications
From the Device Profile screen (see section 8.2), click on the +/- 
button next to General Settings, then click on Communications 
Ports. 
The following submenu appears:
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Double-click on the port you would like to change. 
The Communications Settings screen appears: 

This screen displays the Device Profile’s settings for the meter’s two programmable 
Communications Ports: Address, Baud Rate, Data Bits, Parity, Stop Bits, Transmit Delay, 
Communication Protocol, Network Option and Internal Modem Option. 

You may use the on-board display or one of the meter’s External Displays to learn the 
current baud rate, address and communication protocol of each meter port. The settings 
for the Optical Port are fixed and cannot be changed. Port 1 and Port 4 are the meter’s 
RS-485 ports and are used for RS- 485 communication with a variety of devices. Port 3 is 
an internal modem or Ethernet. Ports 1 and 4 are factory set at 115200 and 9600 baud 
rates, Modem Gateway is 38,400 maximum.

Make changes to this screen according to the requirements of your 
application, by clicking on the box or pull-down menu of any of the 
following settings:

• Address: Assign an address to each port to communicate with 
other devices. Multiple Meters on an RS-485 bus must each have 
a unique address set for the port that is connected to the bus. 
Type in unique address.

• Baud Rate: The baud rate entered in this field must match the 
baud rate of the device that will be connected to the Meter at this 



CHAPTER 8: GE COMMUNICATOR EXT GENERAL SETTINGS

EPM 9800 ADVANCED POWER QUALITY METERING SYSTEM – USER GUIDE 8–17

port. Use 9600 for modem connections. From the pull-down 
menu, select 4800, 9600, 19200, 38400, 57600, or 115200.

• Data Bits: for Modbus RTU and ASCII, leave the Data Bits at 8. 
Other protocols may require a different setting. Use the pull-
down menu to select from: 5, 6, 7 or 8.

• Parity: for Modbus RTU and ASCII, leave the Parity at None. Other 
protocols may require a different setting. Use the pull-down 
menu to select from: None, Even, Odd, Mark or Space. ï 

• Stop Bits: for Modbus RTU and ASCII, leave the Stop Bits at 1. 
Other protocols may require a different setting. Use the pull-
down menu to select from: 1, 1.5 or 2.

• TxDelay (Transmit Delay): leave the TxDelay at 0ms unless you 
are using equipment that requires a delay in the response time, 
such as a radio modem. Use the pull-down menu to select from: 
0ms, 10ms, 20ms, 30ms, 40ms, 50ms, 60ms, 60ms or 70ms.

• Protocol: Direct Connections made through EPM 9800 Advanced 
Power Quality Metering System must use either Modbus RTU or 
Modbus ASCII protocol (Modbus RTU is recommended). Modem 
Connections made through EPM 9800 Advanced Power Quality 
Metering System must use Modbus ASCII only. Use the pull-down 
menu to select from: Modbus RTU, Modbus ASCII or DNP 3.0. See 
Chapter 2 of the GE Communicator EXT Guide for details.

•  Mode (Port 4 only): If you are using I/O modules, set this port to 
Master mode. Set the port to operate at 57600 baud. To change 
the setting, use the pull-down menu to select Slave or Master. 
Make other changes for your application.

• Internal Network Option: If your Meter has the Internal Network 
Option, see your Network Administrator for the correct settings. 
Settings will vary from network to network.

If your meter has the INP100 Option (10/100BaseT) and you click 
on the Advanced Settings button, the following set of screens will 
appear. The meter is shipped with initial settings, or you can fully 
configure the settings using these screens and FTP Client. The 
process is detailed in Chapter 6 of the GE Communicator EXT 
Guide. 

Note This screen is not supported by meters with the INP10 Option
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.

• Internal Modem Option: If your meter has this option, set the 
number of Rings to Answer from the pull-down menu. Set the 
Baud Rate to 57600, or to match your system baud rate.

• Dial Out Profile: Click the Dial Out Profile button and the 
following screen appears. Details on programming this screen 
and on the Modem Dial In/Dial Out Function are in Chapter 9 of 
this manual. This feature is ordered as INP 2.
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Note Any changes you make here may adversely affect communications. For example, if you 
change the baud rate of the port connected to a computer, be sure to make the same 
change to the computer port’s baud rate. If you change a port’s address, be sure to update 
the address settings of any device that communicates with the port. The baud rate of the 
port used by the Meter’s External Display should always be set to 9600 and the address set 
to 1.

• Edit Gateway Port Devices: The Edit Gateway Port Devices 
button at the bottom of the screen is used to Enable up to 8 
devices that are connected the gateway and are to be 
monitored. When the user clicks the Edit Gateway Port Devices 
button, this screen is displayed: 

Click on the box next to the Device to be monitored. 
A Device Address will appear next to the Enabled Device. 

Change the Device Address, if needed, to any address except 1. 
The Number 1 is always reserved for the Primary Device. 

Click OK to return to the Modem Programming screen.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

Click on the Update Device button. 
This sends the new profile to the EPM 9800 Meter. 

Reset Logs.
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8.3.7 DNP Custom Classes Map
The DNP Custom Class Map is a useful tool for prioritizing the readings in your system and 
the frequency of the readings. The DNP Custom Class Map also keeps your system free 
from thousands of unwanted readings.

From the Device Profile screen (section 8.2), click on the +/- button 
beside DNP Custom Class Map. 

Double-click on a DNP Custom Class Map parameter. 
The following set of screens appears. (EPM 9800 meters support 
DNP V3.00 Level 2.  See Chapter 17 of the GE Communicator EXT 
Guide for details.)

8.3.8 Custom Modbus Map

EPM 9800 Custom Modbus Map 

You can select up to 256 Registers (or the equivalent of 2K, whichever is lower) to provide 
the functionality you want from your Meter. In addition, you can customize selected values 
for Format Type, Scaling, Byte Order, Data Size, etc.
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From the Device Profile screen (section 8.2), click on the +/- button 
beside Custom Modbus Map or double-click on the Custom 
Modbus Map line. 
The screen appears:

Data entry is straightforward. Each type of data is described below. Note that not all 
selections will appear on the screen at the same time. You have to scroll the screen from 
right to left to reach some of the functions. Certain entries (such as Format, Data Size, etc.) 
have different allowable selections depending on the data point used. The pull-down menu 
will automatically adjust to provide the appropriate selections for that data point.

Note Table of the Most Commonly Used Modbus Map Readings on page 8-18. 

Data Point Selection 
(There are two different ways to select a Data Point.)

Refer to the Modbus Map and find the associated Line and Point for 
the value you want. 
When you enter those values into the table, the software will 
complete the associated Group and Channel.

OR

Double-click the Group field. 

From the pull-down menus, select a Group and Associated 
Channel value. 
The software will complete the Map and Line values.

• Number of Registers
The number of registers polled for this Data Point is automatically 
computed. The number is dependent on the Data Size selected in 
the Data Size column.

• Start Register
Start Register numbers are automatically assigned. The registers 
are assigned and adjusted automatically to take into account 
previous entries and data sizes. This is the Start Number for the 
first register to use in polling.

• Format 
From the pull-down menu, select a type of Format for a value 
such as Floating, Integer, etc.
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• Data Size 
From the pull-down menu, select the Number of Bytes you want 
to represent the Data Point.

• Unit 
If the polled value is viewed as an integer, the Unit field tells you 
where to place the decimal point. 
Example: If you select .01, a polling value 1234 would be 
interpreted as 12.34. 
Example: If you select 100, a polling value 1234 would be 
interpreted as 123400. 

• Pri/Sec
The meter normally computes values in secondary units. Where 
applicable, you may select primary or secondary. If Primary is 
selected, the value is multiplied by the appropriate CT and/or PT 
values.

• Sign/Abs 
Where appropriate, you may have the option of having the data 
point computed as a signed or absolute value.

• Byte Order 
For most of the Data Points, the user can select the polling order 
of the number of bytes selected by the Data Size field. Example: 
For a four-byte Data Point, the bytes can be arranged in any 
order for polling purposes.

• Display/Modulo/Offset 
Depending on the Data Point selected, you may select one or 
more additional options with the appropriate subselections.
Display: For certain Data Points, interpretation and display 
options are offered.
Example: For An Angle values, you can represent and display as 0 
to 360 degrees or -180 to +180 degrees, etc. Selections will 
appear in a pull-down menu for the associated point.
Modulo: Certain values are cumulative and can roll over and start 
recounting from zero. For those values, where required, you can 
enter a point at which the rollover will occur.
Offset: Where allowed, you can enter a value (offset) which will be 
added to the data point when it is computed.

Table 8–2: Custom Modbus Readings

Line Point Description

34 0 One Second Phase to Neutral Volts: Volts AN

34 1 One Second Phase to Neutral Volts: Volts BN

34 2 One Second Phase to Neutral Volts: Volts CN

35 0 One Second Auxiliary Volts: V Aux

36 0 One Second (A, B, C): 1A

36 1 One Second (A, B, C): 1B

36 2 One Second (A, B, C): 1C
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37 0 One Second Measured N Current: 1Nm

38 0 One Second Calculated N Current: 1Nc

39 0 One Second Phase to Phase Volts: Volts AB

39 1 One Second Phase to Phase Volts: Volts BC

39 2 One Second Phase to Phase Volts: Volts CA

40 0 One Second VA (A, B, C): VA A

40 1 One Second VA (A, B, C): VA B

40 2 One Second VA (A, B, C): VA C

41 0 One Second VA Total: VA Total

42 0 One Second One Second VAR (A, B, C): VAR A

42 1 One Second One Second VAR (A, B, C): VAR A

42 2 One Second One Second VAR (A, B, C): VAR A

43 0 One Second VAR Total: VAR Total

44 0 One Second One Second Watts (A, B, C): Watts A

44 1 One Second One Second Watts (A, B, C): Watts B

44 2 One Second One Second Watts (A, B, C): Watts C

45 0 One Second Watts Total: Watts Total

46 0 One Second Frequency: Frequency

47 0 One Second Power Factor (A, B, C): PF A

47 1 One Second Power Factor (A, B, C): PF B

47 2 One Second Power Factor (A, B, C): PF C

48 0 One Second Power Factor Total: PF Total

49 0 One Second Imbalance: Voltage

49 1 One Second Imbalance: Current

216 2 Block Window Average Watt

217 3 Maximum Block Window Positive Watt

217 4 Maximum Block Window Negative Watt

218 3 Minimum Block Window Positive Watt

218 4 Minimum Block Window Negative Watt

194 4 Phase A-N/Phase A-B Voltage THD

195 0 Phase B-N/Phase B-C Voltage THD

196 0 Phase C/Phase C-A Voltage THD

Table 8–2: Custom Modbus Readings
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Use the buttons at the bottom of the screen to Clear All, Clear, 
Cancel or Print your selections.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click the Update 
Device button to send the new profile to the meter.

197 0 Phase A Current THD

198 0 Phase B Current THD

199 0 Phase C Current THD

Table 8–2: Custom Modbus Readings
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8.4 Revenue and Energy Settings

“Revenue and Energy Settings” is the second group of settings in the 
Device Profile.

From the Device Profile screen (see section 8.2), click on the +/- 
button or double-click on the Revenue and Energy Settings line. 
All of the settings in the Revenue and Energy Settings Group are 
listed.

Click on the particular programmable setting you would like to 
configure. 
The settings will be detailed in the order they appear on the Device 
Profile screen.
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8.4.1 Energy Scaling
From the Device Profile screen (see section 8.2), click on the +/- 
button or double-click on the Energy Scaling line. 
The following set of screens appears:

Using the EPM 9800 Energy Scale Setting screens, the user can 
select the Number of Digits, Decimal Point Placement and Energy 
Unit for displayed readings. 

Click on the tabs to navigate between screens, except for Global 
Settings.  Click on Global Settings to access that screen.

• Energy

Watt Hour (Above)

VA Hour

VAR Hour
• Uncompensated Energy

VA, Watt and VAR readings not adjusted by Transformer Loss 
Compensation.
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• Test Mode Energy

Energy Readings while in Test Mode.

• Pulse Accumulation

Accumulators

Aggregators
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• I and V Squared T Readings

I2T: Data will not accumulate until Current reaches programmed 
level.

V2T: Data stops accumulating when Voltage falls below 
programmed level.

• Q Hours

Q Hours are obtained by lagging the applied voltage to a 
wattmeter by 60 degrees.
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• Global Settings

Settings configured on one screen apply to screens associated 
with filled-in rows. If a row is left blank, the associated screen is 
not modified.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

Click on the Update Device button.
This sends the new profile to the EPM 9800 Meter.
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8.4.2 Program Demand Integration Intervals (Demand Intervals)

See EPM 9800 Installation and Operation Manual for details on Demand 
Integration.

From the Device Profile screen (see section 8.2), click on the +/- 
button or double-click on the Demand Integration Intervals line.
The following submenu appears:

Double-click on any of the settings and the Demand Integration 
Programming screens appear:

Click on the tabs at the top of the screens to navigate from one 
screen to the others. 

Make changes to the screens according to the requirements of 
your application.

Following is a brief description of each setting and its function.

• Thermal Averaging Time Interval Window (above): Allows you to set hours, 
minutes and seconds for a precise thermal window of demand data.
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• Block Averaging Time Interval Window: Sets the length of the Block Interval used 
for Demand Calculation and other Interval-based functions.

• Block Window Sync: Synchronizes the meter with pulses from a High 
Speed Input connected to another meter. 

Click Generate End of Interval Pulse on the lower section of the 
above screen (not shown) to produce a synchronizing output and 
select a Relay and Pulse Width for the output.

• Rolling Average Subinterval Window: Sets the length of the Demand Subinterval 
when Rolling Demand is used. (Subinterval Length X Number of Subintervals = 
Length of Demand Interval Window)

• Rolling Subintervals: Sets the number of Rolling Demand Subintervals in 
the Rolling Demand Window. (Subinterval Length X Number of 
Subintervals = Length of Demand Interval Window)

• Predictive Rolling Window Average: Increasing the length of the 
Predictive Demand Window increases the accuracy of the prediction by 
including more of the Current Demand Window (up to 100%).
Decreasing the length of the Prediction Window gives earlier warnings 
of high demands.
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When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button to send the new profile to the meter.

8.4.3 Internal KYZ Outputs (and Test LED Settings)
The Internal KYZ Outputs Settings allow you to assign channels to the KYZ Outputs and to 
the Test LED Test. The Channel Selection sets the type of pulse that will be generated. 

For example, the Test LED can generate Energy Pulses for conventional testing or Reactive 
(VARh) Pulses for complex testing and approvals. The settings also allow you to determine 
the frequency and the duration of the pulse for each output and for the Test LED.

From the Device Profile screen (section 8.2), click on the +/- button 
beside Internal KYZ Settings or double- click on the Internal KYZ 
Settings line. 
The screen appears:

Click on the arrow of the pull-down menu next to KYZ Output to 
which you would like to assign a channel. 

Make changes to: 

Watt Hour per Pulse, 

Pulse Width, 

Mode and Form, 

for each output and for the Test LED. 

Note on Form: Form A = Transition. Form C = Pulse.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the EPM 9800 Meter.

Note If your EPM 9800 meter is equipped with the KYZ Output Option, the KYZ Output Settings 
will appear. Otherwise, only the Test LED will appear on the screen.
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8.4.4 Display Configuration
From the Device Profile screen (section 8.2), click on the +/- button 
beside Display Configuration or double-click on the Display 
Configuration line. 
The following set of screens (Meter Display Programmable Settings) 
appears:

Click tabs at the top of the screens to access the Programmable 
Settings.

• Display Modes: 

Enter a three-letter Label for each of the three View Modes. 
Enter a Description for each View Mode using the Line 1 and 2 
Description windows.

• Screen Assignments: 
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Enter up to 16 screens for each View Mode. 
Your label for each View Mode appears at the top of each column.

• Power and Energy Display: 

Set Scale, Digits and Decimal Point . 
Previews appear at the bottom of the screen. 

Settings on this screen control the display of energy related 
numbers. Care should be given to match the values on the 
display with those in historical logs. These settings apply to VA-
hours, Watt-hours (+/-), VARhours (+/-) and VAR-hours 
(quadrants) in the meter. 

Scale factor is the user-programmable setting that determines 
how measurements made by the meter will be displayed. In most 
applications, the measurements made in the metering circuit on 
the secondary side on the Instrument Transformers are displayed 
as Primary Values using the Scale Factor.

The Scale Factor (Primary Value = Secondary Value X Scale 
Factor) and the Transformer Factor (TF = Voltage Transformer 
Ratio X Current Transformer Ratio) are the same for energy 
measurements. 

For display of voltage and current measurements, VTR and CTR 
are used.

Note Scale Factor takes precedence over all other settings, i.e. - all other settings are based on 
this setting.
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• Miscellaneous: 

Set Screen Settings, Optical Port and User Inactivity Time-outs. 
The Screen Settings replace Adjustments Mode in the default 
profile. 

• Screen Settings: 

Set Back Light Level (brightness), Back Light Time (when Back Light 
shuts off), Contrast, Scroll Stop, Phasor Rotation and  Cumulative 
Demand. 

• Cumulative Demand Settings: 

Set to: 
Regular: Running Total 
Continuous: Running Total + Current Max/Min.

• Optical Port: 

Set Baud Rate and Optical Receive (Normal or Inverted). 
Inverted Operation is used with the Smart Coupler.

• User Inactivity Time Outs: (number of minutes since last user action when Mode 
reverts to View Mode 1). 

• Settings are: 
5 - 60 minutes. 
Leave Test Mode After_ Minutes: Reverts with or without energy 
accumulation. 
Leave View Mode 2 or 3 After _ Minutes: Reverts Automatically.

• Use Buttons for Functions below: 
• Update Display: 

Must click to update the display. After settings update, View Mode 
1 is displayed. 

• Retrieve from Display: 

Click to retrieve existing settings. 
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• Cancel: 

Cancel any new settings and return to main EPM 9800 Advanced 
Power Quality Metering System screen. 

• Save: 

Save new settings to a file. 

• Load: 

Load saved settings from a file. 

Click Update Display to send new display settings and return to 
main EPM 9800 Advanced Power Quality Metering System screen.

Note See the EPM 9800 Installation and Operation Manual for further details.

8.4.5 CT and PT Compensation
From the Device Profile screen (see section 8.2), click on the +/- 
button beside CT and PT Compensation or double-click on the CT 
and PT Compensation line. 
The following screen appears:

Check the Enable CT box to Enable CT and PT Compensation. 
(Leave unchecked to Disable. )

Click OK to close the screen and return to the main EPM 9800 
Advanced Power Quality Metering System screen.

Note The term "Potential Transformer" was changed to "Voltage Transformer" by the IEEE in 
1982. Most Instrument Transformers now use the term Voltage Transformer.
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8.4.6 Transformer/Line Loss Compensation
From the Device Profile screen (see section 8.2), click on the +/- 
button beside Transformer / Line Loss Compensation or double-
click on the Transformer / Line Loss Compensation line. 
The following submenu appears:

This screen displays the current values for the meter’s Transformer Loss Compensation.

• %LWFE = Percent Loss of Watts due to Iron ï 

• %LVFE = Percent Loss of Vars due to Iron ï 

• %LWCU = Percent Loss of Watts due to Copper

• %LVCU = Percent Loss of Vars due to Copper

Consult Appendix B of the GE Communicator EXT Guide, on 
Transformer Loss Compensation in the appendix pages of this 
manual.

Double-click on any of the loss values,“%LWFE” etc. 
The Transformer and Line Loss Compensation screen appears (see 
next page).

Click on TLC Calculator to find the values to enter into the Percent 
Loss windows. 
The Calculator button will launch an Excel Spreadsheet which will 
do the calculations for you once the required data is entered. A 
copy of the Excel Spreadsheet with example numbers is in 
Appendix B of the GE Communicator EXT Guide. 

EPM 9800 Advanced Power Quality Metering System will automatically launch the Excel 
Spreadsheet as part of its software package. But, for the TLC Button to work, you must 
have the Excel program in your system. If you do not have Excel software or if the 
spreadsheet file is not in the GE Communicator directory, a Warning will be displayed 
instead of the worksheet. You can do your own calculations using the hardcopy 
Transformer Loss Compensation Worksheet in Appendix B of the GE Communicator EXT 
Guide.

Note For most Excel users, this spreadsheet will not run until permission is given to run the 
Macros contained in the sheet. This is done by changing the Excel Security Setting from 
High to Medium.
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The Excel Command

From Excel Toolbar, select Tools > Security > Options.

On the Security Tab Pag, click on the Macro Security button.

Select Medium Security.
This setting allows Excel to run in EPM 9800 Advanced Power 
Quality Metering System.

Enter the percent Loss of Watts and Vars for copper and iron in the 
appropriate fields. 

Enable Transformer Loss Compensation by selecting Iron only, 
Copper Only or Both Iron and Copper from the pull-down menu at 
the bottom of the screen.

With the second pull-down menu, select from the following:

• Add to Watts and Subtract from VAR
• Subtract from Watts and Add to VAR.
• Add to Watts and VAR.
• Subtract from Watts and VAR.

With a third pull-down menu, apply the loss based on the power 
flow direction. From the menu select one of the following:

• Both +Watts and -Watts.
• -Watts only.
• +Watts only.
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Do NOT use the last settings if you do not have the appropriate firmware. Check with 
Technical Support if you have a question.

When all settings are complete, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the EPM 9800 Meter.

8.4.7 Cold Load Pickup
From the Device Profile screen (see section 8.2), click on the +/- 
button beside Cold Load Pickup or double-click on the Cold Load 
Pickup line. 
The following submenu appears, showing the current settings for 
Cold Load Pickup.

Double-click on one of the parameters and the following screen 
appears:

• Cold Load Pickup: Delay can be 1 to 60 minutes or Disabled. 
This value is the delay from the time control power is restored to 
the time when the user wants to resume demand accumulation.

• Minimum time control power must be off before using Cold Load 
Pickup: Value is set from 0 to 255 seconds.

When all changes are entered, click OK to return to the main 
Device Profile screen.

Note For these changes to take effect, you must click on the Update Device button to send the 
new profile to the Meter



8–40 EPM 9800 ADVANCED POWER QUALITY METERING SYSTEM – USER GUIDE

REVENUE AND ENERGY SETTINGS CHAPTER 8: GE COMMUNICATOR EXT

8.4.8 Cumulative Demand Type
From the Device Profile screen (see section 8.2), click on the +/- 
button beside Cumulative Demand Type or double-click on the 
Cumulative Demand Type line. 
This window appears:

Click the radio button in front of Rolling (sliding) Window or Block 
(fixed) Window to select Cumulative Demand Type.

Click OK to exit the screen and return to the main EPM 9800 
Advanced Power Quality Metering System screen.

8.4.9 Energy, Pulses and Accumulations in the Interval
From the Device Profile screen (see section 8.2), click on the +/- 
button beside Energy, Pulses and Accumulations in the Interval 
or double-click on the Energy, Pulses and Accumulations in the 
Interval line. 
This window appears:

Set the number of minutes for the Energy Interval. 
This the Demand and Accumulation Interval Duration.

Click OK to close the window and return to the main EPM 9800 
Advanced Power Quality Metering System screen.

8.4.10 Pulse Accumulations
This section of the Device Profile displays a series of eight running totals available on 
Meter. Each total can be added to (or subtracted from) other totals. This allows you to set 
the high speed inputs located directly on the meter to pulse accumulate. 
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Note If you use these inputs for pulse accumulations, do not set them to record waveforms. If 
you do, endless waveforms record.

From the Device Profile screen (see section 8.2), click on the +/- 
button or double-click on the Pulse Accumulations line. 
The following screen will appear:

Purpose of Pulse Accumulations

Pulse Accumulators are used to accumulate pulse information from external devices. 
These devices may be gas, water or electricity meters, energy management systems, 
SCADA devices or any pulse-generating device. Pulse accumulation is a very flexible 
way to accumulate information from external devices. Using the meter’s pulse 
accumulator, pulses from other meters can be algabraically combined with the host 
meter’s accumulations to generate one reading for a set of meters in a complex 
arrangement.

• Source: This is the particular input on the meter which will be accumulated. 

Units/Pulse: This is the scale factor which normalizes the pulses so that they 
can be aggregated, if desired. Pulses are stored in primary values.

Accumulator: This allows you to place the pulse register into a separate 
accumulation register, which can aggregate or net values. 

User assigned label: This window allows a user to enter a label designation so 
that when reading the Aggregator, the meter will display the source.

To add or subtract data, use pull down menu in each window of 
Accumulator column(s).

Note EPM 9800 supports Negative Averaging for Total Values.
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When all data has been entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. This sends the new profile to the meter.
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8.5 Power Quality and Alarm Settings

This is the third group of settings in the Device Profile.

From the Device Profile screen (see section 8.2), click on the +/- 
button or double-click on the Power Quality and Alarm Settings 
line. 
All of the settings in this group are listed.

Click on the particular Programmable Setting you would like to 
configure. 
The settings will be detailed in the order they appear on the Device 
Profile screen.

8.5.1 Limits
Limit settings are based on a percentage of the Full Scales (% of FS), which are set in the 
Limit and Waveform Full Scales section of the Device Profile (section 8.3.2). Full Scales are 
based on CT and PT ratios set in the CT, PT Ratios and System Hookup section of the Device 
Profile (section 8.3.1) (120V L-N, 208V L-L and 5A).

Before programming Limits, set the CT and PT ratios first. 

Then, set the Limit and Waveform Full Scales. 
The software automatically updates the Full Scale. However, you 
can set it separately from the CT and PT Ratios.
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From the Device Profile screen (see section 8.2), click on the +/- 
button beside Limits or double click on the Limits line. 
The following submenu appears:

This screen displays the current Device Profile’s settings for 
Limits. Not all limits are shown above; “Limit ID” extends to 32.

Double-click on any of the settings (“Limit ID 01:”, etc.) 
The Limits screen appears.

Percentage of Full Scale settings 

The limits are set in % of full scale (% of FS) so that when a user creates a profile, he can 
keep his settings. This is true, even though the CT and PT Ratios change when the meter (or 
a new meter) is placed in a different location. Changing the CT and PT Ratios will not effect 
the % of full scale limits previously set. This is useful when using large numbers at meters

Make changes to this screen according to the requirements of your application:

To set the type of limit and the channel assigned to it, double-click 
in either the Type or Channel column. 

From the pop-up menu, choose the desired settings and click OK.

To designate the limit as either Above or Below a percentage of the 
Full Scale, click once in each Settings column and select the 
desired setting from the pull-down menu.
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To set the percentage of the Full Scale at which the limit will trip, 
enter the value in the % of FS column. 
EPM 9800 Advanced Power Quality Metering System automatically 
calculates the Primary value.

The Combination Limit 3 is the logical combination of Limit 1’s state and Limit 2’s state.

Example 1:

Limit I D:

Type: 1 Second Readings

Channel: Volts AN

Limit 1 Setting: Limit exceeded if Volts AN is below 12V.

Limit 2 Setting: Limit exceeded if Volts AN is above 132V.

Combination Limit 3 Setting: AND If Limit 1 AND Limit 2 are exceeded then 
Limit 3 is exceeded.

Example 2:

Limit I D:

Type: 1 Second Readings

Channel: Volts AN

Limit 1 Setting: Limit exceeded if Volts AN is below 12V.

Limit 2 Setting: Limit exceeded if Volts AN is above 132V.

Combination Limit 3 Setting: OR If Limit 1 OR Limit 2 are exceeded then Limit 3 
is exceeded.

To combine Limits of different Limit IDs, use the Relay Logic Diagrams.

Full Scale settings are shown in the lower left of the screen. These values are set in the 
Limits and Waveform Full Scales section of the Device Profile (section 8.4).

To set the Power Factor Limits, double click on any of the Power 
Factor settings in the Limit 1 or Limit 2 column.
The Power Factor Programming Screen will appear:

Power Factor is broken into four quadrants. The screen lets you set a limit in two of the four 
quadrants. 
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To set a limit from the pull-down menus, select a Quadrant and 
Less Than or Greater Than (Full Scales). 

Type in the Power Factor Number. 
The graph will illustrate your selections by shading the Out of Limit 
bands. The area of the graph not covered by shading is within 
Normal Operational Range. Method 1 Quadrants: Q1 +Lag, Q2 -
Lag, Q3 -Lead, Q4 +Lead.

To display a graph of Method 2 Quadrants: Q1 +Lag, Q2 -Lead, Q3 
+Lag, Q4 -Lead, go to the Programming Labels screen (section 8.19) 
of the Device Profile. 
In the lower drop down menu, click on Method 2. 

Return to the Limits screen. 

Click on any PF setting in the Limit 1 or Limit 2 column.

Note This meter is a real four quadrant meter. Therefore, limits can be set for capacitive and 
inductive PF when generating or consuming power.

When all settings are complete, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the Meter. 

You may Reset Logs after updating the device. See section 8.26.
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8.5.2 ElectroLogic Relay Control
To edit a Device Profile’s ElectroLogic Relay settings:

From the Device Profile screen (see section 8.2), click on the +/- 
button or double-click on the GE Relay line. 

The following screen appears. This screen displays the current Device Profile’s settings:

To assign an item to the RelayLogic Tree: 

Select an Input for the tree by clicking on a bullet next to numbers 1 
through 8.

Choose Limits or Digital Inputs by clicking on the bullet in front of 
the word.

Select the Limit or Input you want to assign to the RelayLogic Tree 
Input you selected.

Press Set to confirm your selection and the software will place the 
selection in the appropriate window in the screen.

After you have assigned all the RelayLogic Inputs, select the gates 
that will be used to combine the logic to trigger the relay. 

To select a gate, click on the gate or choose one from the 
dropdown menu below the gate.

To change items on the RelayLogic Tree, use the following steps:
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To change the selected relay and/or relay modules, select from the 
drop-down menu at the upper right hand corner of the screen.

To change the relay Set Delay, select from the drop-down menu to 
the right of the Set Delay Label.

To change the Relay Reset Delay, select from the drop-down menu 
to the right of the Reset Delay Label.

To clear an item from the Relay Tree, click on that item then click 
the Clear button.

To clear ALL ITEMS from the Relay Tree, click the Clear Assigned 
Items button.

Note In order to use this screen, you must have purchased at least one External Relay Out 
module. For more details on External Modules, see Chapter 11 of the GE Communicator 
EXT Guide.

8.5.3 PQ Thresholds (Waveform Recording)
The Power Quality (PQ) and Waveform Thresholds setting determines at what point the 
Meter will execute a waveform capture and/or record a power quality event. See Chapter 8 
of the GE Communicator EXT Guide for how to view logs.

PQ and waveform thresholds are given as a percentage of the Full Scales (% of FS). Set the 
Full Scales in the Limits and Waveform Full Scales section of the Device Profile (section 8.4). 
Full Scales are based on the CT and PT ratios set in the CT, PT Ratios and System Hookup.

Note Before programming the PQ and Waveform Thresholds, set the CT and PT ratios. 
Then, set the Limits and Waveform Full Scales.

CAUTION: Changing the CT and PT Ratios will Reset the meter and clear all logs and 
accumulations. Be sure to capture needed meter information before changing CT and PT 
Ratios.

Note on Sampling Rate

A higher sampling rate allows for transients to be monitored. Generally, users will set the 
monitor to 128 samples per cycle for this purpose. Lower sampling rates have advantages 
because they allow you to record more cycles of information per event screen. Low 
sampling rates are better for long duration events, like motor starts or distribution faults. 
The meter enables users to tailor the recording for both these applications. For more 
information on Sampling Rate, see the graph on page 8-39.
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From the Device Profile screen (see section 8.2), double-click on the 
PQ Thresholds (Waveform Recording line; 
The Waveform—CBEMA Profile screen appears:

1. Software Triggers: 

To set the threshold for a PQ event and waveform capture, enter 
the desired percentage of Full Scale in the Value(%) column of the 
Above Setpoint and Below Setpoint sections. 
Full Scales are shown in the lower right corner of the screen.

Note Note on CBEMA 

The CBEMA plotting is a power quality standard known world-wide for recording the 
amount of damage voltage transient conditions have done to the equipment being 
monitored. The meter automatically records this information. For CBEMA purposes, 
the user programs internal set points for voltage below 90% and above 110% of full 
scale (+/- 10% from the nominal voltage). These setpoints are defined by the ITI 
(CBEMA) specification. The ITI (CBEMA) Curve is published by Information Technology 
Industry Council (ITI) and is available at: 

http://www.itic.org/iss_pol/techdocs/curve.pdf. 

A user can set a recording with tighter voltage limits to trigger a waveform recording. 
However, CBEMA plotting will be based only on the limits internally set.

Note Note on Setting the Meter to Record Current Faults

As discussed, the voltage setpoints are used to record voltage type events, such as 
voltage surges, sags and transients. The current settings are used to record faults on 
the line or in-rush currents from devices such as motors. Typically, to catch these 
events, set the limit to above 200% of full scale.

2. Waveform Clipping Threshold: EPM 9800 Standard Hardware - 91.0924A Peak before 
clipping.
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3. Hardware Triggers: 

To enable a Waveform or PQ recording for any of the 8 High Speed 
Inputs, click in the appropriate box. 
This will trigger a recording based on a contact trigger. This is 
useful to monitor an open device and to capture the waveform 
during that operation.

4. Samples per Cycle:  

To choose the Samples per Cycle to be recorded at 60 Hz, click on 
the Sampling Rate pull down menu. 

Choose from 16, 32, 64, 128, 256 and 512 samples per cycle. 
The number of samples per cycle you choose will inversely affect 
the number of cycles per capture.  

• If you select 256, a Capture Only pop up screen will ask you to 
select Volts A, B, C or I A, B, C.

• If you select 512, a Capture Only pop up screen will ask you to 
select one of the individual channels.

As you increase the number of samples, you will record more detailed information. The 
Table below illustrates the “Effects of Sampling Rate” on the number of cycles captured. 
Increasing the Sampling Rate increases Waveform Definition but reduces the length of the 
observed window. The approximate length of the observed window is shown in the last 
column. 
For example, to observe events of approximately 1/2 Second, a Sampling Rate of 32 
Samples per Cycle or less should be used.

Note Note on Waveform Event Captures

A screen of data is one capture. If you set Total Captures to 3 and you are recording at 16 
samples per cycle, you will record: 

16 Samples: 3 x 64= 192 cycles of recorded waveforms

128 Samples: 3 x 8= 24 cycles of recorded waveforms

Table 8–3: Effects of Sampling Rates

Samples 
per 

Cycle
Channels

Samples 
per 

Channel

Cycles per 
Capture

Time 
(Approx.)

Analog HSI

16 7 8 1024 64 1 second

32 7 8 1024 32 1/2 second

64 7 8 1024 16 1/4 second

128 7 8 1024 8 1/8 second

256 3 8 2048 8 1/8 second

512 1 8 4096 8 1/8 second
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With the 2 MB module, you have a total of 64 total captures. With the 4 MB module, you 
have a total of 96 captures. You can partition the memory in any fashion required for the 
specific application. There is no limitation on the amount of cycles that can be recorded 
per event.

To choose the total amount of captures, click on the Total 
Captures pull down menu. 

Select from 0 to 96 captures. 
The higher the number, the more information you will be “stringing 
together”.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the Meter.

8.5.4 EN 50160 Flicker
With the Flicker Settings screen, the user can set the test times for the Flicker function.

From the Device Profile screen (section 8.2), click on the +/- button 
beside EN50160 Flicker or double- click on the Flicker Settings 
line.
This screen appears

From the pull-down menus, select a Short Term test time and a 
Long Term test time. 
Typical values for PST and PLT are 10 minutes and 120 minutes.

From the Frequency pull-down menu, select 50 or 60 Hz.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the EPM 9800 Meter.

Note Flicker is discussed in detail in Chapter 16 of the GE Communicator EXT Guide.
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8.5.5 I Squared T and V Squared T Thresholds
With the I Squared T and V Squared T Thresholds screen, the user can set at what point the 
Current and Voltage should accumulate.

From the Device Profile screen (section 8.2), click on the +/- button 
beside I Squared T and V Squared T or double-click on the 
I Squared T and V Squared T line. 
This screen appears:

Input the desired thresholds.

Click OK to exit the screen and return to the EPM 9800 Advanced 
Power Quality Metering System main screen.

8.5.6 High Speed Inputs
This section of the Device Profile enables you to label the eight High Speed Inputs. Using 
this storage field allows a user to label the inputs so that when the data is later analyzed, 
the user knows the source of the status change.

From the Device Profile screen (see section 8.2), click on the +/- 
button or double-click on the Digital Inputs line. 

Double-click on High Speed Inputs. 
The following submenu appears:
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Double-click on any of the Input # lines.
The High Speed Digital Input Assignments screen appears.

Double-click on the Input you would like to label. 

Enter text in each field. 

Click OK to return to the main Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the EPM 9800 Meter.
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8.6 Trending Profile Settings and Load Profile Recording

This section of the Device Profile enables you to set the Trending Profiles for historical logs.

From the Device Profile screen (see section 8.2), click on the +/- 
button or double-click on the Trending Profile Settings line. 
This submenu appears:

Double-click on one of the Trending topics to access the 
programming screens.

Load Profile Recording - Definition

Load Profile Recording is a subset of the Meter’s more general Logging and Trending 
capability. The same screens are used for setup but Load Profile Recording only deals with 
Accumulated Values; Energy (Wh), Reactive Energy (VARh) and Apparent Power (VAh).

Historically, Load Profile Recording referred to recording of Quadrant 1 Energy (Wh) 
because electromechanical meters only measured energy and were detented to prevent 
reverse rotation outside of Quadrant 1.

8.6.1 Trending Log Time Intervals
Trending Log Time Intervals determine the interval at which Historical Logs 1 and 2 will 
take a snapshot. To set the parameters for the logs, see section 8.6.2.

See Chapter 8 of the GE Communicator EXT Guide for how to view and retrieve logs.

From the Device Profile screen (see section 8.2), click on the +/- 
button beside Trending Log Time Intervals or doubleclick on the 
Trending Log Time Intervals line. 
This submenu appears:

This screen displays the current Device Profile’s Trending Log 
TimeIntervals. The values shown are for example only.
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Double-click on either Log 1 Interval or Log 2 Interval.
The Interval Log Setting screen appears:

Enter the hours, minutes and seconds for each log. 
The logs will be time-stamped based on the meter’s time, which is 
set using the Tools menu. See section 8.10.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the meter. 

It is recommended that you Reset Logs (see section 8.11) when 
changing settings that effect the logs.

8.6.2 Trending Setup
The Trending Setup controls the channel assignments for Historical Logs 1 and 2. To set 
the Time Intervals for these Logs, see section 8.6.1. See Chapter 8 of the GE Communicator 
EXT Guide for how to view logs.

From the Device Profile screen (see section 8.2), click on the +/- 
button beside Trending Setup or double-click on the Trending 
Setup line. 
The following submenu appears:

To change the settings for Log 1 double-click on Log 1. To change 
the settings for Log 2 click on Log 2. The Snapshot Channel 
Assignment Log 1 or 2 screen appears:
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Make changes to this screen according to the requirements of your application:

Type: Using pull down menu, select the type of snapshot.

Channel: Using pull down menu, select a channel for the 
snapshot.

Click on Add to include the selections in the Log; click on Remove 
to delete.

To Remove multiple items, hold Control while clicking items to be 
removed and click Remove.

To Remove a range of items, click the first item, hold Shift , then 
click the last item, then click Remove.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

Click on the Update Device button to effect changes. 

Resetting Logs is recommended (see section 8.9).

Total Bytes Used and Bytes Remaining screens display the memory status for that 
particular file. The Meter assumes 256 bytes of memory for each file. Total memory is 
determined at time of purchase.
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8.6.3 Pad Missing Records for Historical Logs
When the meter is not in normal operation, it will not record any data for Log 1 and Log 2. 
For example, during firmware updates or loss of power, data will not be saved. Some 
applications may require data logs to contain those missing records.

To remedy this problem, you can Enable the feature in View > Options > Log 
Retrieval. 

Click the Pad Meter Log File box in front of the feature. 

Click OK.

This feature pads missing records for Log 1 and Log 2. The software causes the Log 
Converter program to automatically pad the missing records with a value of 0 for each log 
retrieval process and stores them in the Log DB file.

By default, if the Meter Trending Interval is set for Greater than 1 Hour, the meter will 
always save a record on the hour in the Trending Logs.
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8.7 External Devices

This setting of the Device Profile configures the Meter’s External Devices, a variety of I/O 

From the Device Profile screen (see section 8.2), double-click on the 
External Devices line.
The following screen appears.

Click in the Type column and use the pull down menu to select the 
specific I/O you wish to add 

Enter a unique address for each. 

Use the Edit buttons to configure each module further. 

Click OK to return to the main Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the EPM 9800 Meter. 
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8.8 Set and Retrieve Meter Time

The EPM 9800 uses its on-board clock for time-stamping any logs it is recording. 

To set the meter’s clock:

Select Tools > Set Meter Time. 
The meter’s On-board Clock screen appears:

To synchronize the meter and your computer, leave the Use PC 
Time box checked.

To set the date and time to be independent from the PC, deselect 
the Use PC Time box and enter the time and date settings.

Click the Send button to update the meter’s time settings.

To retrieve the Meter device’s current time and date settings:

Select Tools > Retrieve Meter Time. 
This screen appears. Date and running time display in LEDs.

Click OK to return to the main EPM 9800 Advanced Power Quality 
Metering System screen.
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8.9 Reset Meter Information

From the menu bar select Tools > Reset Meter Information. 
The following set of screens appears:
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Click on the tabs to navigate between screens.

Click on the box beside the value(s) you would like to reset. 

Click OK.

Note If you click Reset Logs, a Warning will appear asking you if you want to Save Connected 
Device Settings. Click on the settings you would like to save, then proceed with the 
Update. If you do not save the settings, they will be overwritten.

For each box you select, a window will appear which states that the “Reset is 
Completed”. 

Click OK. 
The reset is completed.

You can password protect this feature by enabling the Password feature of the meter. 
(See Chapter 12 of the GE Communicator EXT Guide for details).
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8.10 Manual Waveform Capture

From the Menu bar, click on Tools > Manual Waveform Capture. 
The Manual Waveform Capture screen (shown here) appears, if the 
connected device is an EPM 9800.

This screen displays the Waveform Log Statistics of the logs that have possible 
Waveform Triggers.

Click the Trigger Now button at the bottom of the screen to create 
a waveform. 
EPM 9800 Advanced Power Quality Metering System creates a 
Waveform in Meter memory. 
The Records on the screen will increase by 1. 

To retrieve the Waveform, from the Menu Toolbar, click Logs > 
Retrieve Log from the device

Click OK to return to the main Device Profile screen.
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8.11 Test Mode Preset Accumulators

There are two reasons why a user might want to use the Preset Accumulators screens:

1. A meter in Test Mode is out of service and is therefore not monitoring 
accumulations. The New Value can be used to adjust for the values not 
monitored while in Test Mode.

2. When replacing an old meter, that has accumulations, with a new meter that 
has no accumulations, the New Value can be set with the value of the 
accumulations of the old meter.

Setting Test Mode Preset Accumulators for EPM 9800

From the menu bar select Tools > Test Mode > Preset 
Accumulators. 
The set of screens shown here appears.
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Each screen has a Current Value, New Value and Preset Box for each accumulator. A 
new meter will have zeros for Current Values.

Click Tabs at the top of the screens to access the individual 
screens.

Settings can be preset for the following sets of values: 

• Primary Energy

• Secondary Energy

• Primary Energy (Quadrants)

• Secondary Energy (Quadrants)

• Internal Input  Accumulators

• KYZ Output Accumulators

• I & V Squared T Accumulators

• Cumulative Demand (Secondary) 

• Uncompensated Energy and Q Hours

Click the Preset Boxes for the values you want to set. 

Click Set or Cancel.
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8.12 CT and PT Compensation

The CT and PT Compensation feature allows users to remove the error caused by the CTs 
(external to unit) and PTs that are connected to the unit.

Enable CT and PT Compensation:

The steps:

From the Device Profile (Revnue and Energy Settings), click CT & PT 
Compensation > State.

Enable CT & PT Compensation. 

To send the new profile to the meter click OK and click Update 
Device Profile. 

Exit Device Profile.

Click Tools > CT & PT Compensation > Calibration Table Status

Click the First Time CT & PT Comp Selection.

Click Preload CT & PT Comp with Initial Values. 

Click OK.
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Click Tools > CT & PT Compensation > View Callibration Tables.

Click Copy Factory Table to CT & PT Comp Table. 

Click OK.

CT & PT Compensation is now Enabled and ready for corrections.

Collect data to determine the correction required.

Compensate CTs & PTs:

Click Tools > CT & PT Comp > Compensate CTs & PTs.

Follow direction on screens. Click tabs to make additional 
corrections. 

Click OK.
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